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Copyrights and Notices 

© Agilent Technologies, Inc. 2003-2005  

No part of this manual may be reproduced in any form or by any means (including electronic 
storage and retrieval or translation into a foreign language) without prior agreement and written 
consent from Agilent Technologies, Inc. as governed by United States and international copyright 
laws.  

Additional Notices: 

The material contained in this document is subject to change without notice.  

Agilent Technologies makes no warranty of any kind with regard to this material, including, but 
not limited to, the implied warranties of merchantability and fitness for a particular purpose. 
Agilent Technologies shall not be liable for errors contained herein or for incidental or 
consequential damages in connection with the furnishing, performance, or use of this material. 

Adobe®, Acrobat® are U.S. registered trademarks of Adobe Systems Incorporated. 

Notepad®, WordPad®, Windows®, and Microsoft® are U.S. registered trademarks of Microsoft 
Corporation. 

Other trademarks and copyrights are owned by the respective companies mentioned in this 
document. 
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Introduction to the Agilent Quality Tool 

Introduction to the Agilent Quality Tool 

Welcome 

 

 

 

 

Welcome to the Agilent Quality Tool! 

The Agilent Quality Tool is a statistical process control and quality control (SPC/SQC) tool for the 
Agilent 5DX, Agilent SJ Series, and Agilent SP Series test systems. The Agilent Quality Tool 
provides quick and easy access to actionable information on quality, line throughput, and false 
calls.   

When the Agilent Quality Tool is used in conjunction with the Agilent Repair Tool and Agilent test 
and inspection systems, you can apply SPC and SQC methods to improve assembly and test 
processes. These process improvements can help you meet your company's targeted quality 
levels. 

There are several ways to find information about the Agilent Quality Tool. Click any topic in the 
Help Table of Contents or press the F1 function key from any screen in the Agilent Quality Tool to 
get Help related to that topic. 
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Features and Benefits of the Agilent Quality Tool 

Features Benefits 

Pre-Repair Quality Monitoring 

• Easy access to real-time 
yield, DPMO and defect 
information for both AXI 
and AOI 

• Real-time alarms 

 

• Real-time information allows timely response to 
process changes 

• Timely process improvements result in increased 
first pass yield 

• Higher first pass yield provides lower costs and 
improved profits 

Post-Repair Quality Monitoring 

• Real-time process 
information after the 
repair step 

• Agilent Repair Tool data is 
integrated for Post-Repair 
Quality monitoring 

 

• Real-time information allows timely response to 
process changes 

• User may compare Pre-Repair and Post-Repair 
quality 

• Provides an accurate measure of true yield 
(eliminates false calls) 

Throughput Analysis 

• Ability to monitor 
throughput efficiency and 
work in progress (WIP) 

• Efficiency trend charts 

 

• Provides visibility into repair WIP and throughput 
which allows reduction of repair WIP 

• Provides opportunity to improve efficiency of test 
and repair loops 

False Call Analysis 

• Provides ratios of 
False:Total Failed or 
False:Real calls 

• Absolute numbers of false 
calls or average false calls 

 

• Allows analysis of false call drivers 
• Knowledge of false call drivers results in the 

faster flow of material through the assembly 
processes and on to the customer 

• Higher confidence in test data for quality control 
and process control 

Intelligent Drill-Downs for Charts 

• Drill-downs display most 
likely source of root 
causes 

• Pre-configured drill-downs 
for all standard charts 

 

• Provides, with one click, the information most 
likely needed to determine root causes 

• Minimizes user training needed to identify areas 
for process improvement  
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Introduction to the Agilent Quality Tool 

Features Benefits 

Spreadsheet Export 

• User is able to select 
specific data and time 
frame, whether or not 
data appears on a chart 

• Exported file is compatible 
with Microsoft Excel©  

 

• User may perform further data analysis and 
create custom charts with Microsoft Excel© or 
other spreadsheet programs 

• Provides users with a tool to answer ad-hoc 
process questions  

• Allows process engineers to conduct more 
advanced SQC analysis 

Historical views of real-time 
charts 

• Ability to create historical 
views of any real-time 
chart 

 

• Allows comparison of real-time charts to other 
time periods 

• Provides quality reporting metrics to monitor 
quality targets 

• Helps identify system process issues 
• Enables reporting of yield or other metrics for 

OEM-CM relationships 

Real-time alarms 

• User may set alarm limits 
on any chart 

• User is notified when 
alarm occurs 

• All alarm events are 
recorded and logged 

 

• Users can quickly pin-point specific defects that 
generate a process alarm 

• Enables faster corrective action, resulting in 
higher first pass yields 

 

Runs on the ITF Server 

 

 

• A solution that is scalable to the number of test 
systems and Client PCs in your manufacturing 
environment 

• The same ITF Server may be used for the Agilent 
Repair Tool and the Agilent Quality Tool 

• Provides simplified data management 
• Enables integrated test and repair analysis 

across multiple test systems and test platforms 
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Minimum System Requirements 

For the Agilent Quality Tool to work correctly, communication links must exist between the 
Intelligent Test Framework Server, Client PCs, and test systems. The test systems may be any 
combination of Agilent 5DX and/or SJ Series test systems. The minimum system requirements 
listed below are necessary in order to establish these communication links. 

1. Client PC(s) with the following minimum requirements: 

Hardware: 

• CPU Pentium® III 800 MHz or higher 

• 512 MB RAM  

• 1GB of free disk space 

• 10/100 TX network interface 

• 17" monitor  (19” or 21” recommended), SVGA or higher resolution (1024 x 768, 
256 colors) 

Operating System: 

• Microsoft® Windows 2000, Service Pack 4 
• Microsoft® Windows XP, Service Pack 2 

2. Test systems with the following software versions: 

Agilent ICT UNIX with software version 04.00p or later 

Agilent ICT WN with software version 3070 04.00p WN or later 

Agilent AXI with software version 7.3 or later 

Agilent AOI SJ Series with software version 4.07 or later 

Agilent AOI SP Series with software version 2.0.0.7 or later 

 The minimum installation requires one Client PC and the Intelligent Test Framework 
(ITF) Server. The individual installation will determine the combination of Agilent SJ Series and/or 
Agilent 5DX systems connected to the ITF Server and the Client PC(s). 
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Getting Help 

Page-Sensitive Help 

Press the F1 key from any screen to see online Help related to that topic. 

 

Printable Help File 

To view a printable version of the Agilent Quality Tool Online Help, 

1. Click Start > Programs > ITF Software Solutions > Agilent Quality Tool > 
Printable Help 

2. The file will automatically open. 

If you see an “Open With” dialog box, your system does not know 
which program to use to open the Printable Help file.  This means that you must 
install Acrobat Reader® on your system before you can open the Printable Help 
file.  Adobe Acrobat Reader software is provided with the Agilent Quality Tool.  It 
is also available from the Adobe web site at http://www.adobe.com   

Adobe Acrobat Reader must be installed on your system to view the Printable 
Help file, which is in Adobe Acrobat format (.pdf).   

3. Print the file if you wish. 

 

Adobe®, Acrobat® are U.S. registered trademarks of Adobe Systems Incorporated. 
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Technical Support 

Agilent Quality Tool and Agilent Repair Tool support is available in the following ways: 

Web support 

The Agilent Technologies Printed Circuit Board Test and Inspection web site is for the benefit 
of owners and users of the Agilent Repair Tool, the Agilent Quality Tool, and Agilent 
Technologies' board test and inspection systems.  

Printed Circuit Board Test and Inspection web address: http://www.agilent.com/see/pcb

 Some information areas require users to log in with a user name and password. 

Topics available from the web site include: 

• Application Notes and Technical Papers 

• Data Sheets, Brochures, Demonstrations and Catalogs 

• Frequently-Asked Questions (FAQs) 

• Manuals, Guides and Notifications 

• Newsletters, Presentations, and Articles 

• Software, Firmware and Drivers 

Phone support 
• Phone-based support is free for the first year and highly recommended for subsequent 

years. 

• Customers in the U.S. may call a 24-hour toll free support phone number: 1-800-447-
TEST.  For customers outside the U.S., please contact your Agilent Technologies 
representative. 

 

Training Information 

A list of education and training opportunities is available on Agilent Technologies' Printed 
Circuit Board Test and Inspection web site.  

1. Connect to the Printed Circuit Board Test and Inspection web site:  

http://www.agilent.com/see/pcb

2. Click Education & Training.  
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Getting Started 

Getting Started 

Data Source 

What is a Data source?  

The Agilent Quality Tool data source specifies the location where the test data is stored. 

When can you change the data source? 

You must change the data source before you log in to the Agilent Quality Tool.  If you are 
currently logged in, you must log out before you can change the data source.   

Why would you change the data source? 

The data source would need to be changed if you need to change the IP Address or hostname, 
for example, when the server is relocated or removed. 

How do you change the data source? 

From the menu bar at the top of the Agilent Quality Tool screen, 

1. Click Tools > Data Source. 

 

2. Select ITF Server name (or IP Address): 

Enter the ITF Server name, IP Address, or type localhost. 

3. Click OK. 

4. Click User > Log in to proceed to log in to the Agilent Quality Tool.  
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Login and Logout 

When the Agilent Quality Tool starts up, the first screen that appears is the Login User screen. 

 The list of user names includes only users with Quality User or Quality 
Administrator privileges. 

To log in, 

In the Login: User Name dialog box,  

1. Select or enter your User Name. 

2. Click OK or press Enter. 
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Getting Started 

In the Login Password dialog box, 

1. Enter your Password or Personal ID Number (PIN), if your company requires 
one.   

2. Click OK or press Enter. 

 

To log out, 

Click User > Log out from the menu bar at the top of the screen. 

To log in again, 

Click User > Log in from the menu bar at the top of the screen. 

The alphanumeric password/PIN must be between 3 and 15 characters in length. 
 User names and passwords are set up by your system administrator in the ITF Administration 
System.   

If you are having problems with Login, see Trouble with Login. 
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Change Password 

If you know your current password, you can change your password to another password of 
three to fifteen alphanumeric characters. 

To change your password, 

1. Click User in the menu bar at the top of the Agilent Quality Tool screen. 

2. Select Change Password. 

3. Enter your current password. 

4. Enter your new password (3–15 alphanumeric characters). 

5. Repeat your new password to confirm the change.  

6. Click OK. 

 

 Your system administrator sets up and maintains the list of passwords in the ITF 
Administration System. 
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Getting Started 

Using the Main Screen 

Main Screen Overview 

The first screen you will see is the Main Screen.   

Look for the following items on this example screen: 

1. The Menu bar at the top of the screen. 
2. The current Test Stage.  (AOI is the current Test Stage in this example.) 
3. The current View name in the View name list.  (Starlight-SJ3 is the current View 

name in this example.) 
4. The Main Toolbar with buttons for creating a new view, editing an existing view, 

looking at other (historical) data for a View, and looking at the Alarm Log. 
5. The Tabs.  (Pre-Repair Quality is the active tab in this example.) 

Pre-Repair Quality Tab, Post-Repair Quality Tab, Throughput Tab, False Call Tab

 A tab may also be referred to as a dashboard. 

 When you create a View you may select which tabs you want to see for 
that View.  See tab selection when creating a View. 

6. The Charts   

 Your system administrator defines, in the ITF Administration System, the 
exact charts that will appear when you select each tab.  The charts shown below are 
just examples of what you might see on your tabs.  For a complete list of charts, see 
List of All Available Charts. 

7. The Chart Toolbar from which you can drill-down for more information, see chart 
history, save a chart image, set or modify chart options (including alarms), and see 
the calculation or definition for the current chart. 

 After you click a tab, the other tabs will only be available after all the 
information on the selected tab is displayed, click the Refresh button to fetch the 
chart again.  If not, the chart will be updated the next time the tab is selected. 
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 If the data fetch involves a large amount of data, the following dialog box with a 
progress indicator appears: 
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Getting Started 

Menu bar 

The Menu bar in the Agilent Quality Tool contains the following: 

File: 

From the File menu you can save chart images or exit the Agilent Quality Tool. 

 

User: 

From the User menu you can log in, log out, or change your password. 

 

Stage: 

It is on the Stage menu that you select the test Stage, AOI_SJ (Optical), AOI_SP 
(Optical), or AXI (X-Ray). 

 

Views: 

From the Views menu, you can create a new View, edit or delete an existing View, or 
get to a dialog to show View history. 

 

Tools: 

From the Tools menu you can get to the Event Log, Alarm Log, or a dialog to export 
data to a spreadsheet.  Before you log in you may also change the Data Source. 
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Help: 

From the Help menu you can see the contents of the Agilent Quality Tool online help 
(Contents), the help topic for the current screen (On-Screen), or the version 
information about the Agilent Quality Tool software (About). 
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Getting Started 

Pre-Repair Quality Tab 

The Pre-Repair Quality tab displays charts with test information (pre-repair) for the current 
View.  This information comes directly from the test stations.  

Examples of charts on the Pre-Repair Quality tab: 

• First Pass Yield  

• DPMO  

• Test Calls 

• Failed Components 

• For a complete list, see List of All Available Charts. 

 Your system administrator defines, in the ITF Administration System, the exact 
charts that will appear when you select this tab.   
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Post-Repair Quality Tab 

The Post-Repair Quality tab displays test and repair information for the current View.  Post-
Repair incorporates data from the Agilent Repair Tool (ART).  The charts on this tab display 
data for boards that have passed test or have been completely reviewed at ART.  

Examples of charts on the Post-Repair Quality tab: 

• First Pass Yield  

• DPMO  

• Defects 

• Defective Components 

• For a complete list, see List of All Available Charts. 

 Your system administrator defines, in the ITF Administration System, the exact 
charts that will appear when you select each tab.  
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Getting Started 

Throughput Tab 

The Throughput tab displays charts with throughput information for the current View.  These 
charts are useful for monitoring throughput for test and repair processes as well as work in 
progress (WIP).   

Examples of charts on the Throughput tab: 

• Boards Tested 

• Boards Repaired 

• First Pass Yield (pre-repair) 

• Boards Tested but Not Reviewed 

• For a complete list, see List of All Available Charts. 

 Your system administrator defines, in the ITF Administration System, the exact 
charts that will appear when you select each tab.  
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False Call Tab 

The False Call tab displays charts that are useful for examining your false call levels and 
potential causes.  These charts combine information from test stations with the information 
entered at the Agilent Repair Tool (ART).  

Examples of charts that could appear on the False Call tab: 

• False PPM 

• False:Total Failed 

• False:Real 

• False Called Components 

• False Called Components by Algorithm 

• Average False Calls 

• For a complete list, see List of All Available Charts. 

 Your system administrator defines, in the ITF Administration System, the exact 
charts that will appear when you select each tab.  
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Creating a View 

View Overview 

In your manufacturing environment you may build several types of boards on many different 
assembly lines. You may want to look at quality, throughput and false call charts based on 
different combinations of test stations, board types, and time frames. The way to specify the 
data you want to see on your charts is to create a View using the Create View Wizard.   

A View is a group of selected test stations and board types.  A View defines a subset of test, 
inspection, and repair data that resides on the ITF Server, forming the basis for charts in the 
Agilent Quality Tool.  Views are created and named in the Agilent Quality Tool. 

A View: 

• Is specific to one test stage, either AOI_SJ, AOI_SP, or AXI.    

• Is associated with specific board type(s). 

• Is associated with specific test station(s). 

• Has a unique name.  

• Is stored locally on the Client PC where the View is defined. 

 

Example:   

Assume that it is your job to oversee all "CompanyXBigBoard" boards that have gone through 
AOI inspection during the past 24 hours at your company's manufacturing facility.  You could 
define a new View in the following way: 

1. Make sure the Stage is set to AOI_SJ (Optical). To do this, click Stage > AOI_SJ 
(Optical) on the menu bar. 

2. Select: 

• Board type = CompanyXBigBoard 
• All test stations 
• Detailed view for a single board type  

3. Choose whether you want to (a) combine data for all test stations into a single line on 
the chart or (b) show one line for each test station. 

4. Display data for last 24 hours for trend charts (and last 10 boards for Pareto 
charts). 

5. Give the View a name you like, such as "AOI_SJ CompanyXBigBoard" 

 You must have Quality Administrator privileges to create or edit a View. 
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Create Your First View 

It is simple to create your first View with the Agilent Quality Tool.  

First, we will define a View.  A View is a group of selected test stations and board types.  A 
View defines a subset of test, inspection, and repair data that resides on the ITF Server, 
forming the basis for charts in the Agilent Quality Tool.  Views are created and named in the 
Agilent Quality Tool. 

The Create View Wizard guides you through the following steps: 

Step 1  Select test stations 

Step 2  Select detailed or summary view 

Step 3  Select board type 

Step 4  Select whether to compare or combine data  

Step 5  Select chart time frames 

Step 6  Enter the View name and select the tabs you want to see 

Before you create a new View: 

1. Check to see that you are in the correct Test Stage (AOI_SJ, AOI_SP, or AXI), since a 
new View is always created using the current Stage setting. The Stage is noted near 
the View name list at the top of the Agilent Quality Tool screen.   

2. If you need to change the Stage, click Stage on the menu bar at the top of the 
screen, then click AOI_SJ (Optical), AOI_SP (Optical), or AXI (X-Ray). 

To start the Create View Wizard, click the New View button on the main toolbar.  You 
may also select Views > New View from the menu bar at the top of the Agilent Quality Tool 
screen.   

 If a View has not yet been created on this Client PC, the Create View Wizard will 
start automatically when you log in to the Agilent Quality Tool. 

 The options that you select in the Create View Wizard will apply to every chart in 
that View. 

 A user must have Quality Administrator privileges to edit a View. 
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Creating a View 

Create View - Step 1: Select Test Stations 

Before you create a new View: 

1. Verify that you are in the correct Test Stage (AOI_SJ, AOI_SP, or AXI), since a new 
View is always created using the current Stage setting. The Stage is noted near the 
View name list at the top of the Agilent Quality Tool screen.   

2. If you need to change the Stage, click Stage on the menu bar at the top of the 
screen, then click AOI_SJ, AOI_SP, or AXI. 

The first step in the Create View Wizard is to select the test stations that you would like to 
monitor.  All charts in this View will display data from the selected test station(s).   You can 
display data for any test station connected to the Intelligent Test Framework (ITF). 

  The list of test stations will include all test stations known to the Agilent ITF for 
the current test Stage (AOI or AXI).  At least one board must be tested on a test station for 
that test station to appear on the list.  

If you would like data from all the test stations,  

1. Select the All test stations radio button.  

2. Click Next > to continue. 

 When you select All test stations, this will include new test stations for 
this Stage that might be added to the ITF in the future.   

If you would like data from specific test stations,  

1. Select the Specific test stations radio button.   

The Available box contains a list of all test stations known to the ITF for the current 
Stage (AOI_SJ, AOI_SP, or AXI). 

2. To select the test station(s) of interest, first click the test station name(s), then click > 
to move them to the Selected box.  

 You may also double-click the item to select it. 

3. Click Next > to continue. 

 If you select Specific test stations, the View will not automatically 
include new test stations added to the ITF in the future.  In order to include new test 
stations, you must specifically add them to this View. 
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Example of All test stations: 
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Creating a View 

Create View - Step 2: Select View Type 

The second step in the Create View Wizard is to select the View type. 

If you would like the View to reflect a single board type,  

1. Select Detailed view for a single board type.  

All charts in this View will display data for the single board type you select in Step 3 of 
the Create View Wizard.  The initial charts displayed on each tab will be both trend 
charts and Pareto (bar) charts. 

2. Click Next > to continue. 

If you would like the View to summarize multiple board types, 

1. Select Summary view for multiple board types.   

All charts in this View will display data for the board types you select in Step 3 of the 
Create View Wizard.  Each tab will initially display only trend charts.  After you drill 
down on specific board types, you will also see Pareto (bar) charts. 

2. Click Next > to continue. 

 The View Type is the only setting that cannot be changed after the View has been 
created. 
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Creating a View 

 

Create View - Step 3: Select Board Type 

The third step in the Create View Wizard is to choose the specific board types from which data 
is collected.   

You will see a list of available board types.  

  For more information on the significance of board type names, see Board Type 
Names. 

  The list of board types will include all board types known to the Agilent ITF for the 
current test Stage (AOI_SJ, AOI_SP, or AXI) .  At least one board for a particular board type 
must have been tested in order for that board type to appear on the list.  

If you selected Detailed view for a single board type in Step 2, you may select only one 
board type.   

1. Click the name of the board type you wish to select. 

2. Click Next > to continue. 

 If there is just a single test station selected for your View, the <Current 
board type> option is available in the Board Type box.  This option allows you to 
monitor the current board type at your test station without having to modify the View 
each time the board type changes.  

If you selected Summary view for multiple board types in Step 2, you may select 
multiple board types. 

If you would like this View to include data for all board types,  

1. Select the All board types radio button.  

2. Click Next > to continue. 

 When you select All board types, this will include new board types 
for this Stage that are added to the Agilent ITF in the future.   

If you would like this View to include data from specific board types,  

1. Select the Specific board types radio button.   

The Available box contains a list of all board types known to the Agilent ITF for 
the test station(s) selected in Step 2. 

2. To select the board type(s) of interest, click the board type name(s), then click 
> to move them to the Selected box.   

 You may also double-click the item to select it. 

3. Click Next > to continue. 
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 When you select Specific board types, the View will not 
automatically include new board types tested on this test station in the future.   

 

Example of Single Board type: 
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Creating a View 

Example of All Board types: 
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Create View - Step 4: Compare or Combine 

The fourth step in the Create View Wizard is to choose how you want to display data on all 
trend charts such as Yield and DPMO.  You may either combine all data into a single line or 
view one line on the chart for each test station or board type.   

1. Decide which format you want.  You may choose one of the following: 

Combine all data  

• Combines the data for all test stations and all board types into a single line in 
a trend chart.   

Compare data by test station  

• Compares data by test stations (i.e, trend charts display one line for each test 
station). This is useful if you want to compare the performance of different test 
stations. 

Compare data by board type  

• Compares data by board type (i.e., trend charts display one line for each 
board type). This is useful if you want to compare the quality of different 
board types. 

 This option is not available for Single Board Type Views.  

2. Select the format you want by clicking the radio button that corresponds to your 
choice. 

3. Click Next>. 

 Sometimes an option is not available based on previous choices for the View.  In 
this case the option is grayed out or unavailable. 
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Creating a View 
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Create View - Step 5: Time Frame 

The fifth step in the Create View Wizard is to set time frames or limits for your trend and 
Pareto charts.  

Trend charts can display data collected from the last 4, 8, 12 or 24 hours. 

Pareto (bar) charts can display data based on the number of boards. 

To set the chart time frames, 

1. Trend charts: 

The first time you create a View, the default selection is the last 24 hours. If you wish 
to change this, click the drop-down menu and select 4, 8, or 12 hours.    

2. Pareto (Bar) charts: 

The first time you create a View, the default selection is the last 10 boards.  You may 
type a new number in the text box to change the number of boards for which data is 
shown on Pareto charts. 

3. Click Next > to continue.   
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Creating a View 

Example dialog box when you have selected a Single board type: 
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Example dialog box when you have selected Multiple board types: 
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Creating a View 

Create View - Step 6: View Name and Tab Selection 

The last step in the Create View Wizard is to name your View and select the tabs you want to 
see for this View.   

To name your View and select the tabs, 

1. Enter a name, up to 50 characters, in the View name text box.  The View name must 
be unique to this Test Stage (AOI_SJ, AOI_SP, or AXI. 

2. If you want a tab to be displayed in this View, select its corresponding checkbox in the 

Show column . 

3. Click Finish when you are done.  

Example: 
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Editing a View 

Editing a View 

Once a View has been created, you can edit the various characteristics of that View. 

 When you edit a View, changes take effect immediately.  In order to "undo" a 
change, you must edit the View to restore the previous settings.  

To edit a View, 

1. Verify, before you proceed, that you are in the correct Test Stage (AOI_SJ, AOI_SP, or 
AXI). The Stage is noted at the top of the Agilent Quality Tool screen, near the View 
name list. 

 

If you need to change the Stage, click Stage on the menu bar at the top of the screen, 
then click the correct Stage. 

 

2. Select the View to edit.  Click the down-arrow on the View name list and select the 
View name. 

 

3. To edit this View, click the Edit View button  on the main toolbar of 
the Agilent Quality Tool screen.  You will see a dialog box with five tabs.   

 

You may change information on any of the tabs.  When you are done making changes 
on all tabs, click OK to save your changes and close the Edit View dialog box. 

General tab

Test Stations
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Board types: Single Board Type or Multiple Board Types

Data Combination

Time Frame

 

 When you edit a View, changes take effect immediately.  In order to "undo" a 
change, you must edit the View to the way it was originally.  

 A user must have Quality Administrator privileges to edit a View. 
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Editing a View 

Edit View - General tab 

On the General tab, you may change the name for the current View and the tabs that you 
want to see for this View.   

 The View type may not be changed after a View has been created. 

1. To change the View name,   

Enter a new name, up to 50 characters, in the View name text box.  The View name 
must be unique to this test stage (AOI_SJ, AOI_SP, or AXI). 

2. To add a tab for this View, 

Select the corresponding checkbox for each tab that you want to see for this View. 

 

3. To remove a tab from this View, 

Clear the checkbox for each tab that you do now want to see for this View.  

4. If you need to check or change any information on another tab, click that tab heading 
now.  Otherwise, click OK to save your changes and close the Edit View dialog box. 
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Editing a View 

 

Edit View - Test Stations  

This tab allows you to change the test station(s) that you would like to monitor.  All charts in 
this View display data from the selected test station(s).   You can display data for any test 
station connected to the Intelligent Test Framework (ITF). 

  The list of test stations will include all test stations known to the Agilent ITF for 
the current test Stage (AOI_SJ, AOI_SP, or AXI).  At least one board must be tested on a test 
station in order for that station to appear on the list. 

If you would like data from all the test stations,  

1. Select the All test stations radio button.  

 When you select All test stations, this will include new test stations for 
this Test Stage that are added to the ITF in the future.   

2. If you need to check or change any information on another tab, click that tab heading 
now.  Otherwise, click OK to save your changes and close the Edit View dialog box. 

If you would like data from specific test stations,  

1. Select the Specific test stations radio button.   

The Available box contains a list of all test stations known to the ITF for the current 
Stage (AOI_SJ, AOI_SP, or AXI). 

2. To select the test station(s) of interest, first click the test station name(s), then click > 
to move them to the Selected box.  

 You may also double-click the item to select it. 

If you select Specific test stations, the View will not automatically 
include new test stations added to the ITF in the future.  In order to include new test 
stations, you must specifically add them to this View. 

3. If you need to check or change any information on another tab, click that tab heading 
now.  Otherwise, click OK to save your changes and close the Edit View dialog box. 
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Example of All test stations: 
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Editing a View 

Edit View - Single Board Type 

The contents of the Board Type tab depend on the View type.  You can see the View type on 
the General tab of the Edit View dialog box.  This topic refers to Views where a singe board 
type has been selected.  The tab name will be Board Type. 

  For more information on the significance of board type names, see Board Type 
Names. 

  The list of board types will include all board types known to the Agilent ITF for the 
current test Stage (AOI or AXI).  At least one board for a particular board type must have 
been tested in order for that board type to appear on the list.  

When the View type is "Detailed view for a single board type," you may choose a single board 
type in the list.  You also have the option of selecting "Current board type" if you have 
selected a single test station in Step 1: Select Test Stations or the Test Stations tab. 

To change the board type, 

1. Click the name of the board type you wish to select. 

2. If you need to check or change any information on another tab, click that tab heading 
now.  Otherwise, click OK to save your changes and close Edit View dialog box. 

<Current board type> is the board type currently undergoing test on the specified 
test station.  This option allows you to monitor the current board type at your test station 
without having to modify the View each time the board type changes.  
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Example of Single Board type: 
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Editing a View 

Edit View - Multiple Board Types 

The contents of the Board Type tab depend on the View type.  You can see the View type on 
the General tab of the Edit View dialog box.  This topic refers to Views where multiple board 
types have been selected.  The tab name will be Board Types. 

  For more information on the significance of board type names, see Board Type 
Names. 

  The list of board types will include all board types known to the Agilent ITF for the 
current test Stage (AOI_SJ, AOI_SP, or AXI).  At least one board for a particular board type 
must have been tested in order for that board type to appear on the list.  

When the View type is "Summary view for multiple board types," you may choose All board 
types or Specific board types.  The board types are those tested on the test station(s) you 
chose in Step 1: Select Test Stations or the Test Stations tab. 

If you would like this View to include data from All board types, 

1. Select the All board types radio button.  

 When you select All board types, this will include new board types for 
this Stage that are added to the Agilent ITF in the future.   

2. If you need to check or change any information on another tab, click that tab heading 
now.  Otherwise, click OK to save your changes and close the Edit View dialog box.   

If you would like this View to include data from specific board types,  

1. Select the Specific board types radio button.   

The Available box contains a list of all board types known to the Agilent ITF for the 
test station(s) selected in Step 1: Select Test Stations or the Test Stations tab. 

 When you select Specific board types, this View will not automatically 
include new board types tested on this test station in the future. 

2. To select the board type(s) of interest, click the board type name(s), then click > to 
move them to the Selected box.   

 You may also double-click the item to select it. 

3. If you need to check or change any information on another tab, click that tab heading 
now.  Otherwise, click OK to save your changes and close the Edit View dialog box. 
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Example of Multiple Board types: 
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Editing a View 

 

Edit View - Data Combination 

There are several ways you can display data on the Yield and DPMO trend charts.  You may 
either combine all data into a single line, or view one line on the chart for each test station or 
board type.   

1. Decide which format you want.  You may choose one of the following: 

Combine all data  

• Combines the data for all test stations and all board types into a single line in 
a trend chart.   

Compare data by test station  

• Compares data by test stations (i.e, trend charts display one line for each test 
station). This is useful if you want to compare the performance of different test 
stations. 

Compare data by board type  

• Compares data by board type (i.e., trend charts display one line for each 
board type). This is useful if you want to compare the quality of different 
board types. 

 This option is not available for Single Board Type Views.  

2. Select the format you want by clicking the radio button that corresponds to your 
choice. 

3. If you need to check or change any information on another tab, click that tab heading 
now.  Otherwise, click OK to save your changes and close the Edit View dialog box. 
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Example: 
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Editing a View 

Edit View - Time Frame 

This tab allows you to change the time frame for your trend charts and the data displayed on 
your Pareto (bar) charts. 

• Trend charts can display data collected from the last 4, 8, 12 or 24 hours. 
• Pareto (bar) charts can display data based on the number of boards. 

To set the time frames, 

1. Trend charts: 

To change the time frame, click the drop-down menu and select 4, 8, 12  or 24 hours. 
   

2. Pareto (Bar) charts: 

Type a new number in the text box to change the number of boards for which data is 
shown on Pareto charts. 

3. If you need to check or change any information on another tab, click that tab heading 
now.  Otherwise, click OK to save your changes and close the Edit View dialog box. 
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Example dialog box when you have selected a Single board type: 
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Editing a View 

Example dialog box when you have selected Multiple board types: 
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Using Charts 

The Chart Toolbar 

A chart toolbar appears below each chart.  You can do the following from the chart toolbar: 

  Drill-down for more information

  View historical data for this chart

  Save a chart image

  Edit chart options:  Alarm Tab, Filter Tab or Calculation Tab

 The Chart Options button appears only if the user has Quality 
Administrator privileges. 

  Chart Information:  See the formula or definition of a chart calculation  
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Drill-Down 

The Agilent Quality Tool includes a patented feature called Intelligent Drill-Downs. 
 Intelligent Drill-Downs allow you to "drill-down" on a chart to learn more about the factors 
contributing to the data displayed on that chart.   

• To drill-down on an item in a Pareto chart, simply click the bar of interest on that chart 

or click the drill-down button  on the chart toolbar.  Drill-down charts are available 
when there is a drill-down button on the chart toolbar.  

To drill-down on a line in a trend chart, click the item in the chart legend or click the 
drill-down button on the chart toolbar. 

• To return from a drill-down to the previous chart, click the button on the chart 
toolbar.  

Example: In the screen below, the user sees a Pareto chart showing the most frequent Test 
Calls.  "Solder Bad" is the most commonly-occurring test call at this time. The three charts 
below the Test Calls chart automatically give the user additional information on the first item 
in the Pareto chart ("Solder Bad" in this case). The user sees charts for Failed Components by 
Package Type, Failed Components by Part Number and Failed Components (by reference 
designator).     

 

To continue the example, assume the user wants to find out additional information on the 
"RADO.2-C" package type. This is where a drill-down is very valuable.  The user clicks the 
down-arrow below the Failed Components by Package Type chart.  A new drill-down dialog box 
appears (see below).  The top chart is Failed Components by Package Type, the original chart 
from which the drill-down was activated. The lower chart(s) display the drill-down information 
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Using Charts 

for the selected item. The Failed Components chart indicates the component reference 
designators for package type "RADO.2-C" that had a Solder Bad test call.  

 If the data fetch involves a large amount of data, the following dialog box with a 
progress indicator appears: 

 

 When you click the drill-down button in the chart toolbar, you automatically see 
the drill-down chart(s) for the first item in the chart.  Pin/component package type in AQT is 
not applicable to SP50. Any charts related to package type in SP50 are not relevant.  

To return from the drill-down, the user clicks the up-arrow on the chart toolbar.  This returns 
the user to the previous screen. 
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Chart History 

The Agilent Quality Tool provides the capability to compare current chart data with chart data 
from another time frame.  This is useful if you wish to compare current performance or quality 
with recent quality or performance data that resides on the ITF Server.  

To see chart history,  

1. Click the Chart History button on the chart toolbar. 
2. For Trend charts such as Yield or DPMO, you may set the time frame with either the 

Start date or End date. 

• For Start date, you may choose the start date and the duration.  The end date 
and time will be calculated automatically.  

• Click the Start date radio button 
• Click the Calendar button to select the start date from the calendar. 
• Select the start time from the drop-down box. 
• Select the duration (length of time) from the drop-down box.  The 

choices are Hours (4, 8, 12 or 24) or Weeks (1, 2, 4, 5,10, 15 or 20). 
• Click OK.  

 

• For End date, you may choose the end date and the duration.  The start date 
and time will be calculated automatically.  

• Click the End date radio button 
• Click the Calendar button to select the end date from the calendar. 
• Select the end time from the drop-down box. 
• Select the duration (length of time) from the drop-down box.  The 

choices are Hours (4, 8, 12 or 24) or Weeks (1, 2, 4, 5,10, 15 or 20). 
• Click OK.  
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Using Charts 

 

3. For Pareto charts such as Failed Components, you may select the exact start 
date/time and end date/time.  

• Select the Start date from the Calendar button. 
• Select the Start time from the drop-down box. 
• Select the End date from the Calendar button. 
• Select the End time from the drop-down box.  
• Click OK.  

 

4. A dialog box appears with the original chart on the top and the chart for the selected 
time frame on the bottom.   
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5. If you want to see a chart comparison for a different time frame, click the Edit Time 
Frame... button at the bottom of the dialog box. 

6. Click Close when you are done with this dialog box. 

 Chart History is different than View History (also called History for a View). 
 Chart History is activated from the chart toolbar and shows data from a different time frame 
for a chart.  View History is activated from the main toolbar and shows data from a different 
time frame for an entire View (all tabs, all charts).  
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Using Charts 

Saving Charts 

To save a chart,  

1. Click the Chart Save button on the chart toolbar below the chart. 
2. Choose the file name and location: 

• Choose the file folder 
• Use the default file name or type a new name 
• Choose the image file type.  The default file type is .png, as this format 

provides superior resolution.  If you prefer, you may change the file type to 
.jpg. 

3. Click Save. 

Example: 
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Printing Charts 

If you want to print a chart,  

1. First, save the chart (see Saving Charts).  The chart will be saved as a .png or .jpg 
image file.   

2. Note the file name and location. 
3. Open the image file in another application such as Microsoft Word© or any image 

editing software. 
4. Print the chart image from the software application. 
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Using Charts 

Chart Options 

Chart Options: Alarm Tab 

 A user must have Quality Administrator privileges to change Chart Options. 

Trend (line) charts: 

The Alarm Tab below is an example of a lower limit set on a trend (line) chart.   

In this example, the alarm limit for a yield chart is set to 75. The chart will go into an alarm 
state if the yield drops below 75 percent.  If this were a DPMO chart, the user would instead 
choose a high limit. 
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Pareto (bar) charts: 

The Alarm Tab below is an example when a high limit of 5 is set for a Pareto chart.   

In this example, the alarm limit for a False Called Components chart is set to 5. The chart will 
go into an alarm state if any single component is marked False Call on 5 of the last 20 boards 
on this chart. 
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Using Charts 

Chart Options: Filter Tab 

On the Chart Options, Filter Tab, the Agilent Quality Tool provides the capability to specify the 
placement machine for a particular charts in the AOI Test Stage. This is useful if you want to 
look at components placed by a specific placement machine.  

 The Filter tab is available only for the following charts: (a) Pre-Repair: Test Calls, 
Failed Components, and Failed Components by Feeder and (b) Post-Repair: Defects, Defective 
Components, and Defective Components by Feeder. 

 A user must have Quality Administrator privileges to change Chart Options. 

To set a filter for a specific placement (pick and place) machine,  

1. Click the Chart Options button  on the chart toolbar. 
2. Select the Filter tab. 
3. Click the down-arrow for the placement machines to see the list of available machines. 

  

  The default selection is "Any machine."   

4. Select the placement machine. 
5. Click OK. 

The applied filter will be indicated on the chart except when the placement 
machine is set to "Any machine."   
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Chart Options: Calculation Tab 

 A user must have Quality Administrator privileges to change Chart Options. 

For DPMO charts (Defects Per Million Opportunities), you can specify how you would like to 
define a "defect opportunity." You may choose any of the following: 

• Components 

• Pins (AXI only) 

• Components and pins (AXI only) 

If you select: Pre-Repair DPMO is: 
Components  Total number of failed components per million 

components tested.  
Pins  (AXI only) The total number of failed pins per million pins 

tested. 
Components and pins  (AXI 
only) 

Total number of failed components and failed pins 
per million components and pins tested. 

To set the DPMO opportunity,  

1. Click the Chart Options button  on the chart toolbar below the chart. 
2. Select the Calculation tab. 
3. Click to select either Components, Pins, or Components and pins. 

 Pins options are available only for AXI. 

4. Click OK. 
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 DPMO "Opportunities" are set on an individual chart basis. 
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Chart Information Button 

To see the definition or formula for the current chart, 

1. Click the Chart Information button on the chart toolbar below the chart. 
2. Take note of the definition, formula (if applicable), and notes for this chart metric. 

Definition ............................ 

Formula (if applicable) 

Notes ............................ 

3. Close the dialog box when you are done.   
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List of All Available Charts 

Your system administrator defines, in the ITF Administration System, the exact charts that will 
appear when you select this tab. The following table describes the charts available for display 
on each tab in the Agilent Quality Tool (before Intelligent drill-downs). 

Tab Name Available Charts Chart Description 
First Pass Yield (Pre-Repair) Percentage of boards that passed 

test or inspection. 
DPMO  

 

(Defects per Million 
Opportunities) 

Total number of failed pins, failed 
components, or both per million 
pins, components, or both tested. 

Test Calls 

 

(single board type only) 

Number of failures listed by test 
call. 

Failed Components 

 

(single board type only) 

Number of failed components, 
listed by reference designator. 

Failed Components by Feeder 

 

(single board type only) 

Number of failed components 
placed by a particular placement 
machine and feeder. 

Pre-Repair Quality 

Boards Tested Number of boards tested on the 
specified test station(s). 

 

Agilent Quality Tool Online Help:  Printable Version 71 



 

Tab Name Available Charts Chart Description 
First Pass Yield (Post-Repair) Percentage of boards that contain 

no real defects. 

 

Calculation includes boards that 
passed test or inspection and 
boards that have been completely 
reviewed with the Agilent Repair 
Tool. 

DPMO 

 

(Defects per Million 
Opportunities) 

Total number of defective items 
per million items tested.   

 

For AOI, items = components.  For 
AXI, items = components, pins, or 
components+pins. 

 

Calculation includes boards that 
passed test or inspection and 
boards that have been completely 
reviewed with the Agilent Repair 
Tool. 

Post-Repair Quality 

Defects 

 

(single board type only) 

Number of defects, listed by defect 
name. 

 

Calculation includes boards that 
passed test or inspection and 
boards that have been completely 
reviewed with the Agilent Repair 
Tool. 
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Tab Name Available Charts Chart Description 
Defective Components 

 

(single board type only) 

Number of defective components, 
listed by reference designator. 

Defective Components by 
Feeder 

 

(single board type only) 

Number of defective components 
placed by a particular placement 
machine and feeder. 

   Post-Repair Quality 

Boards Repaired Number of boards repaired using 
the Agilent Repair Tool. 

Boards Tested Number of boards tested on the 
specified test station(s). 

Boards Repaired Number of boards repaired with 
the Agilent Repair Tool. 

First Pass Yield (Pre-Repair) Percentage of boards that passed 
test or inspection. 

First Pass Yield (Post-Repair) Percentage of boards that contain 
no real defects. 

 

Calculation includes boards that 
passed test or inspection and 
boards that have been completely 
reviewed with the Agilent Repair 
Tool. 

Boards Tested but Not 
Reviewed 

Number of boards that failed test 
and have not been completely 
reviewed with the Agilent Repair 
Tool. 

Throughput 

Boards Completed Number of boards that either 
passed test or were completely 
repaired using the Agilent Repair 
Tool. 

False Call False PPM 

 

 

Parts Per Million  

Number of false-called items per 
million items tested.   

 

For AOI, items = components.  For 
AXI, items = components, pins, or 
components+pins. 
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Tab Name Available Charts Chart Description 
False:Real Ratio of false-called items to 

defective items.   

 

For AOI, items = components.  For 
AXI, items = components, pins, or 
components+pins. 

False:Total Failed Ratio of false-called items to failed 
items. 

 

For AOI, items = components.  For 
AXI, items = components, pins, or 
components+pins. 

Average False Calls Average number of false-called 
items per board tested.  

 

For AOI, items = components.  For 
AXI, items = components, pins, or 
components+pins. 

False Called Components 

 

(single board type only) 

Number of false called 
components, grouped by reference 
designator. 

False Called Components by 
Algorithms 

 

(single board type only) 

Number of false called 
components, grouped by 
algorithm. 

  False Call (continued) 

False Called Components by 
Package Type 

 

(single board type only) 

Number of false called 
components, grouped by package 
type. 
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Setting and Viewing Alarms 

Alarm Limits 

The Agilent Quality Tool can notify you when chart data exceeds predefined limits, allowing 
you to quickly identify and address process control issues.  To set alarm limits, see Setting Up 
Alarms.   

When limits are set for a chart, a red line indicates the limit value. 

For Pareto (bar) charts, you can set only an upper limit.  If this limit is exceeded, an alarm 
event occurs and a visual notification is displayed on your Client PC screen.   

 

For trend charts such as Yield and DPMO, you can set either an upper limit or a lower limit.  If 
the last data point on a chart is above the upper limit or below the lower limit, an alarm event 
occurs and a visual notification is displayed on your Client PC screen. 

 

 Trend charts are updated every 30 minutes.  Pareto charts are updated every time 
a board is tested or repaired.  An alarm event occurs if the most recent data, when updated, is 
outside of the alarm limits.  An alarm event is cleared if the most recent data, when updated, 
is within the alarm limits.  
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Setting Up Alarms on the Alarm Tab 

The alarm feature in the Agilent Quality Tool notifies you when chart data exceeds the limits 
that you define.  If a chart triggers an alarm, an alarm dialog box is displayed at the Client PC 
and the alarmed chart is highlighted in red. 

Alarm limits may be set for any individual chart in a View.  Alarms are associated with that 
specific chart in that View. 

 A maximum of eight alarm limits may be set on any single Client PC for a given 
test Stage.  

 Alarm events may occur for charts on tabs and Views that are not currently 
visible.   

To set an alarm for a chart, 

1. Click the Chart Options button   on the chart toolbar below the chart.   This opens 
the Chart Options dialog box.  

Click the Alarm tab.   

2. On the Alarm tab, select the type of limit(s) you want to set. 
a. If this is a trend chart such as First Pass Yield or DPMO, you may set either 

an upper limit or a lower limit.  An upper limit would be useful for charts such 
as DPMO.  A lower limit would be useful for charts such as First Pass Yield.  An 
alarm event occurs if the data goes above the upper limit or below the lower 
limit. 

b. If this is a Pareto (bar) chart, you may set only an upper limit.  An upper 
limit is useful for charts such as Failed Components, Defects, or Test Calls.  An 
alarm event occurs if the limit is exceeded.  

3. Enter the limit value in the Value text box. 
4. Click OK to return to the main screen. 

Repeat the above steps for each chart for which you wish to set an alarm. 
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Setting and Viewing Alarms 

Example:  In this example of Alarm Limits for a First Pass Yield trend chart, the user has set 
a lower limit of 75.  An alarm will be triggered if the yield falls below 75 percent. 
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Example:  In this example of Alarm Limits for a Pareto (bar) chart, the user has set an 
upper limit.  An upper limit is useful for charts such as Failed Components, Defects, or Test 
Calls.  If the limit is exceeded, an alarm will be triggered.   

 

 A user must have Quality Administrator privileges to set alarms. 
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Setting and Viewing Alarms 

 

Responding to an Alarm 

When the data crosses the alarm limit for a chart, 

• A notification dialog box appears on the Client PC screen where the alarm limit was set 

• The chart background turns red  

• An alarm event is recorded in the Alarm Log 

• An alarm symbol appears next to the View name in the View name list 

 Notification will occur for alarm events on all tabs and Views, even those that are 
not currently visible. 

To close the Alarm Notification dialog box and return to the main screen,  

Click OK. 

If there is a check in the "Go to View" check box when you click OK, the next screen 
you see will be the alarmed chart. 

 

Agilent Quality Tool Online Help:  Printable Version 79 



Example of Alarm Notification dialog box: 
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Setting and Viewing Alarms 

Example of alarmed chart in the View: 
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Alarm Log 

When an alarm event occurs, an entry is made in the Alarm Log. The most recent alarm event 
is listed first. 

The Alarm Log provides a list of all the alarms that have occurred on that Client PC and 
includes the following information: 

• Status for the alarm: Active  or Inactive  
• Date and time of the alarm event 
• View name 
• Tab name: Pre-Repair Quality, Post-Repair Quality, Throughput or False Call 
• Chart name 
• The specific defect or component that caused the alarm 
• A snapshot of the chart image at the time the alarm was triggered (click Chart) 
• A brief description of any action taken to deactivate the alarm 

To view the Alarm Log, click the Alarm Log button  on the main toolbar or click Tools > 
Alarm Log from the menu bar. 

Example of an Alarm Log:  

 

An alarm is deactivated if the chart data returns within the set limits.  The status of the alarm 
event in the Alarm Log is then changed to “Inactive” and the red outline on the chart returns 
to its normal color. 

To export the current Alarm Log to a .csv file,  

1. Click Export at the top of the Alarm Log dialog box.   
2. Enter a file name and location. 
3. Click the Save button. 

To close the Alarm Log, 

Click Close.  This will return you to the main screen. 

 Alarm entries are retained in the Alarm Log for 31 days.  
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Historical Data 

Chart History 

The Agilent Quality Tool provides the capability to compare current chart data with chart data 
from another time frame.  This is useful if you wish to compare current performance or quality 
with recent quality or performance data that resides on the ITF Server.  

To see chart history,  

1. Click the Chart History button on the chart toolbar. 
2. For Trend charts such as Yield or DPMO, you may set the time frame with either the 

Start date or End date. 

• For Start date, you may choose the start date and the duration.  The end date 
and time will be calculated automatically.  

• Click the Start date radio button 
• Click the Calendar button to select the start date from the calendar. 
• Select the start time from the drop-down box. 
• Select the duration (length of time) from the drop-down box.  The 

choices are Hours (4, 8, 12 or 24) or Weeks (1, 2, 4, 5,10, 15 or 20). 
• Click OK.  

 

• For End date, you may choose the end date and the duration.  The start date 
and time will be calculated automatically.  

• Click the End date radio button 
• Click the Calendar button to select the end date from the calendar. 
• Select the end time from the drop-down box. 
• Select the duration (length of time) from the drop-down box.  The 

choices are Hours (4, 8, 12 or 24) or Weeks (1, 2, 4, 5,10, 15 or 20). 
• Click OK.  
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3. For Pareto charts such as Failed Components, you may select the exact start 
date/time and end date/time.  

• Select the Start date from the Calendar button. 
• Select the Start time from the drop-down box. 
• Select the End date from the Calendar button. 
• Select the End time from the drop-down box.  
• Click OK.  

 

4. A dialog box appears with the original chart on the top and the chart for the selected 
time frame on the bottom.   
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Historical Data 

 

5. If you want to see a chart comparison for a different time frame, click the Edit Time 
Frame... button at the bottom of the dialog box. 

6. Click Close when you are done with this dialog box. 

 Chart History is different than View History (also called History for a View). 
 Chart History is activated from the chart toolbar and shows data from a different time frame 
for a chart.  View History is activated from the main toolbar and shows data from a different 
time frame for an entire View (all tabs, all charts).  

 

Agilent Quality Tool Online Help:  Printable Version 85 



History for a View 

The View History feature in the Agilent Quality Tool allows you to look at an entire View in 
another time frame.  You can compare current data with past data that resides on the ITF 
Server.   

View History is useful to: 

• Compare current performance or quality to past performance or quality 

• Compare current trends with historical trends 

• Look at trends over longer periods of time 

• Perform drill-downs on charts with longer time periods 

• Troubleshoot longer, systemic problems 

• Create reports 

To use View History, 

1. Click the History... button on the main toolbar.  

2. To set the time frame, you may choose either Start date or End date, and the 
duration of time (for example, 1 week).  

• For Start date, you may choose the start date and the duration.  The end date 
and time will be calculated automatically.  

• Click the Start date radio button 
• Click the Calendar button to select the start date from the calendar. 
• Select the start time from the drop-down box. 
• Select the duration (length of time) from the drop-down box.  The 

choices are Hours (4, 8, 12 or 24) or Weeks (1, 2, 4, 5,10, 15 or 20). 
• Click OK.  

 

• For End date, you may choose the end date and the duration.  The start date 
and time will be calculated automatically.  

• Click the End date radio button 
• Click the Calendar button to select the end date from the calendar. 
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Historical Data 

• Select the end time from the drop-down box. 
• Select the duration (length of time) from the drop-down box.  The 

choices are Hours (4, 8, 12 or 24) or Weeks (1, 2, 4, 5,10, 15 or 20). 
• Click OK.  

 

3. A new screen appears.  The time frame is displayed above the tabs.  

 The time frame is the same for all charts in the View History dialog box 
(both trend charts and Pareto charts).   

 

4. If you want to see the View for a different time frame, click the Edit Timeframe 
button. 
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5. When you are done with the View History dialog box, click the Close button. 

 Chart History is different than View History.  Chart History is activated from 
the chart toolbar and shows data from a different time frame for a chart.  View History is 
activated from the main toolbar and shows data from a different time frame for an entire View 
(all tabs, all charts).  
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Exporting Data 

Spreadsheet Export 

The Agilent Quality Tool allows users to export test and repair data to a .csv file for analysis.   

 The .csv file can be imported into Microsoft Excel© or other spreadsheet 
programs.  

To export specific Agilent Quality Tool data to a spreadsheet,  

Click Tools > Export Data to Spreadsheet...  from the menu bar at the top of the 
Agilent Quality Tool screen. 
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Example Dialog box: 

 

To specify the data to export,  

1. Choose the Test Stage (AOI_SJ, AOI_SP, or AXI).  The default is the current test 
stage.   

2. Select the test station(s) and board type(s).  The default selections are the board 
types and test stations for the current View.  If you wish to change the test station 
and board type selections, click the Edit Test Stations or Edit Board Types button.  

3. Choose the way you will select boards: 
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Exporting Data 

• Test Time:  includes data for all boards that were tested during the specified 
time frame 

• Repair Time: includes data for all boards that were repaired during the 
specified time frame 

• Serial Number: includes data for all boards within the specified range of serial 
numbers 

4. Specify the time frame or range of serial numbers: 

• If you are selecting boards by test or repair time,  

Select the specific start date/time and end date/time.  (The default is the time 
frame for the current View.) 

• If you are selecting boards by serial number,  
• For a single serial number, enter the number in the "Start serial number" 

field. 
• For a range of serial numbers, enter the Start and End serial numbers. 

 

5. Choose the spreadsheet content that you want to see in the output file:   
• Detail level:  Choose (a) Board level analysis or (b) Defect level analysis 

Choose Board-level analysis to get information about test and repair events 
such as the time the board was tested, the number of test calls, etc. Board level 
analysis would be useful if you wanted to calculate metrics such as yield or the 
number of boards tested. 

Choose Defect-level analysis to get detailed information about the individual 
defects or repair actions on the board tested. Defect level analysis would be 
useful if you needed to analyze a specific process problem such as which 
components had the most failures or the most commonly occurring defects. 

• Data Selection  

Select the columns to appear in the spreadsheet.  Click the check boxes to 
include the items you want.   

The list of available items depends on the detail level you selected. 

6. Click the Advanced button if you want to specify whether to export (a) only test or 
repair activity within the specified time frame (the default choice) or (b) all test or 
repair activity for the boards in the time frame, even if outside of the specified time 
frame.  Click OK when you are done. 

Agilent Quality Tool Online Help:  Printable Version 91 



 

 

6. Click the Options button if you want to specify whether to export (a) only the latest 
repair data for a board (the default choice), or (b) all repair data for a board.  Click OK 
when you are done. 

 

Example of Options:  Suppose that you have a board with one defect, an Open on C1. 
Repair Operator 1 opens the board in the Agilent Repair Tool (ART) and marks C1 as 
Repair Later, then closes the board.  Operator 2 opens the board in ART, repairs C1, 
marks C1 as Repaired, and then closes the board.    

• If, when you are exporting data, you choose in the Options dialog box to 
export "only the last repair data for a board," the exported data would reflect 
only that C1 was Repaired.   
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Exporting Data 

• If you instead choose to export "all repair data for a board," the exported data 
would report both operations on C1:  first that it had been marked "Repair 
Later" and then that it had been "Repaired." 

7. Click the Export... button on the Spreadsheet Export dialog box. 
8. In the Save or Save As dialog box,  

• Select the folder  

• Type the file name 

• Click OK 

 The file type is always .csv 

9. Click Close when you are done exporting data. 
10. Open the .csv file with a spreadsheet program such as Microsoft Excel©. 
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Optimizing Agilent Quality Tool 

Introduction 

This chapter illustrates the effective use of the Agilent Quality Tool in production environment 
so as to enable you to set the Agilent Quality Tool views according to your use models and 
needs. 

First, let us recognize the nature of Agilent Quality Tool: 

• What Agilent Quality Tool is 

It is used strategically for viewing a small window of production data to assist 
supervisor, engineer and manager to monitor the production parameters. Charts are to 
be used sparingly to monitor certain production status so as to minimize the resources 
used on the ITF server while achieving the purpose of monitoring the production data.  

• What Agilent Quality Tool is not 

It is not a tool used for viewing/exporting large amounts of production data in 
conjunction with the ITF applications running at live production.  It is not a charting 
tool that fits all the needs of the applications. When working with live production, it 
should not be configured with maximum views/charts using large amounts of 
production data for analysis. Doing so this will draw resources away to the ITF server, 
thus impeding the performance of Agilent Quality Tool. 

Hence, we group the use models into two types: real-time and offline mode. Activities that 
draw much of the process power and memory would be classified under the offline mode. A 
good example of a use model under the offline mode would be exporting of production data 
from ITF. On the other hand, processes that require quick responses from the ITF Server 
would be under the real-time mode. 
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Agilent Quality Tool Parameters that are Sensitive to ITF 
Performance 

The following Agilent Quality Tool parameters are sensitive to the performance of the ITF 
Server: 

1. Agilent Quality Tool views 

• Duration 

• View by board types 

• View by last # of boards (sample size) 

• Number of Views and charts configured for Agilent Quality Tool applications 

2. Export parameters 

• Duration 
• Table parameters 
• Volume of data to be exported 

3. Other parameters those are sensitive to Agilent Quality Tool performance 

• Scheduled/deliberated LME operations 
• ITF currently serving large production data 
• Agilent Repair Tool data migration in ITF 3.1 
• Switching of Agilent Quality Tool views 

 

Strategy in Designing or Choosing Agilent Quality Tool Charts 

The following is a list of recommended guidelines for designing or choosing Agilent Quality 
Tool charts: 

• Understand your production volume. 
• Identify the parameter/s you want to monitor. 
• Identify the data volume associated with the view. 
• Select the least possible number charts. 
• Create different view for different users, instead of loading all views into 1 application. 
• Test out your Agilent Quality Tool view with low volume of data first. 
• Fine-tune your Agilent Quality Tool view. 
• Schedule your Agilent Quality Tool spreadsheet export only during low production 

volume, else execute it periodically, not exceeding 400 records each time. 
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Learning Tools 

Recommended Process Flow for Real-time Mode 

The following is the recommended process flow for use models that fall under the real-time 
mode category. 
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Pre-conditions for Real-time Mode in Creating a View 

1. Log into the Administration System.  
2. Click Application. 
3. Click the tester type, AOI_SJ, AOI_SP, or AXI. 
4. Select Single Board Type or Multiple Board Type. 
5. Modify the setting to remove charts that are not required from each tab. 
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Learning Tools 

Options for Selecting Test Stations 

• All test stations  

This option applies to the offline mode use model.  

Select this mode when all testers connected to server are down. This option requires more 
server CPU time and memory.  

• Specific test stations  

This option applies to the real-time mode use model provided one test station is selected.  

Select this mode if you want to lower the amount of server CPU time and memory 
required. 

 

Options for Selecting View Type 

• Detailed View for a single board type 

This option applies to the real-time mode use model.  

All charts in this View will display data for the single board type you select in Step 3 of the 
Create View Wizard.  

The initial charts displayed on each tab will be both trend charts and Pareto (bar) charts. 

• Summary View for multiple board types 

This option applies to the offline mode use model. 

All charts in this View will display data for the board types you select in Step 3 of the 
Create View Wizard.  

Each tab will initially display only trend charts. To display Pareto (bar) charts, drill down 
on specific board types. 
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Options for Selecting Board Types 

If you have selected Single Board Type in Step 2 of the Create View Wizard, select the single 
board type listed in the Create View Wizard (Step 3 of 6) dialog box. 

This option applies to the real-time mode use model. 

Example: 

 

If you have selected Multiple Board Types in Step 2 of the Create View Wizard, you can 
select one of the following options in the Create View Wizard (Step 3 of 6) dialog box: 

• All board types 

This option applies to the offline mode use model.  

Select this option when all testers connected to server are down. This option requires 
more server CPU time and memory. 

• Specific board types 
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Learning Tools 

This option applies to the real-time mode use model provided one board type is selected.  

Select this option if you want to lower the amount of server CPU time and memory 
required. 
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Options for Combining or Comparing Data 

• Combine all data  

This option applies to the real-time mode use model.  

Select this option when all testers connected to server are down. This option requires 
more server CPU time and memory. 

• Compare data by test station 
Compare data by board station  

This option applies to the offline mode use model. 

Select this option if you want to lower the amount of required server CPU time and 
memory.  
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Options for Selecting Chart Time Frames 

If you have selected Single Test Station in Step 1 of the Create View Wizard and Single 
Board Type in Step 2, set the following for real-time mode use model: 

• Trend charts: Display data for last 4 hours 
• Pareto charts: Display data for last 100 Boards 
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If you have selected Multiple Board Type in Step 2, set the following to reduce the amount 
of processing time required: 

• Trend charts: Display data for last 4 hours 
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Learning Tools 

Options for Selecting Tabs 

For real-time mode, select only the tabs that are required. 

 

 

Options for Exporting Data 

Exporting of data requires a substantial amount of CPU time and memory. Thus, it is 
recommended that exporting of data be done offline without any real-time processes running 
at the background.  

To minimize the amount of time taken to export data, you may do the following: 

• Set a shorter period for the report. For example, you may want to export one day's of 
data for a board. Instead of exporting all 24 hours of data at one go, you can export 4 
hours of data each time and do this for 6 times. 

• In the Data selection table, select only the data you require. 
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Conclusion 

Customizing a good set of parameters for Agilent Quality Tool ensures strategic data collection 
for the monitoring of production performance. At the same time, it ensures good system 
performance. A good understanding of the more intricate aspects of system design is essential 
and beneficial. It helps to ensure a more effective and efficient implementation of ITF. 

Agilent is committed to continuously developing and enhancing the performance of Agilent 
Quality Tool. With Agilent Quality Tool now supporting more than one type of use models, it is 
recommended that you select the one that best suits your needs. 
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Troubleshooting 

Trouble with Login 

If your User Name and/or PIN do not match the list of allowed users, you will receive an error 
message.   

• Check whether you should enter your User Name in upper case (USER NAME) or lower 
case (user name).  

• Make sure the Caps Lock button has not been accidentally pressed, as this could 
change the way the computer reads your User Name or PIN. 

• Verify that your password/PIN is alphanumeric, between 3 and 15 characters in 
length. 

• Try logging in again. 

If you still have problems logging in, contact your system administrator. 
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Data Source 

What is a Data source?  

The Agilent Quality Tool data source specifies the location where the test data is stored. 

When can you change the data source? 

You must change the data source before you log in to the Agilent Quality Tool.  If you are 
currently logged in, you must log out before you can change the data source.   

Why would you change the data source? 

The data source would need to be changed if you need to change the IP Address or hostname, 
for example, when the server is relocated or removed. 

How do you change the data source? 

From the menu bar at the top of the Agilent Quality Tool screen, 

1. Click Tools > Data Source 

 

2. Select ITF Server name (or IP Address): 

Enter the ITF Server name, IP Address, or type localhost. 

3. Click OK 
4. Click User > Log in to proceed to log in to the Agilent Quality Tool.  
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Appendixes 

Board Type Names 

The handling of board type names differs slightly between the Agilent Quality Tool and the Agilent 
Repair Tool (ART).  In ART, board type refers to a specific CAD file.  The Agilent Quality Tool does 
some grouping of ART board types.  One board type in the Agilent Quality Tool may refer to several 
boards types in ART. 

In ART, the board type is comprised of three fields: 

• Board Type 

• Board Revision 

• Assembly Revision 

In the Agilent Quality Tool, the board type is comprised of one field: 

• Assembly Revision 

• For AOI, the Assembly Revision comes from the "Board" field in the REP file. 

• For AXI, the Assembly Revision come from the Agilent 5DX Panel Program Name. 

 

How the Agilent Quality Tool uses IPC Standards 

The Agilent Quality Tool is based on ANSI/IPC standards 2547 (CAMX) and 2511 (GenCAM).  

IPC standards documents are available at: http://webstds.ipc.org

Agilent Quality Tool Online Help:  Printable Version  111 

http://webstds.ipc.org/


User Roles 

A user with Quality User privileges can: 

• Open Views 

• Drill-down to more charts 

• Save chart images 

• Respond to alarms  

• View the alarm log 

• Look at chart history or View history 

A user with Quality Administrator privileges can also: 

• Create Views 

• Edit Views 

• See charts based on operator (False:Real by Operator and False:Total Failed by Operator) 

• Modify Chart Options, including: 

Set Alarms Alarm Tab
Set placement machine filter Filter Tab
Define DPMO calculation Calculation Tab

 

Which data is included when there are multiple test and repair cycles? 

Pre-Repair 

• Test data includes the test results of each board test.  By default, AOI_SJ, AOI_SP, and AXI do 
not support retest. 

Post-Repair  

• Test data includes the test results of each board test.  By default, AOI_SJ, AOI_SP, and AXI do 
not support retest. 

 In order for test data for a failing board to be reflected in AQT, the board must be 
completely reviewed with ART.  

• Repair data: 
• Includes data for the last repair session. 
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Working in Comfort 

To optimize your comfort and productivity, it is important that you set up your work area correctly and 
use your equipment properly.  With that in mind, Agilent Technologies has developed some set-up and 
use recommendations for your work station.  Please read the information in the link below to learn 
important information based on established ergonomic principles.  

Working In Comfort document  
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Chart Information 

This section describes the information that can be displayed on the charts. 

Pre-Repair Quality 

DPMO, Components only (Pre-Repair) 

Definition Total number of failed components per million components tested. 

(Defects per Million Opportunities)     
 

Formula 

 

 

million 1
Tested  Components
Failed   Components *  

 
Notes • A component with multiple failures is counted only once. 

• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 

 

DPMO, Pins only (Pre-Repair) 

Definition Total number of failed pins per million pins tested. 

 

 

Formula 

 

 

million 1
Tested  Pins
Failed   Pins *  

 

Notes • Only available for AXI. 
• A pin with multiple test calls is counted only once. 
• Pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 

Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
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DPMO, Pins + Components (Pre-Repair) 

Definition Total number of failed components and failed pins per million components and pins 
tested. 

(Defects per Million Opportunities)   

 

Formula 

 

 

million 1
Tested  Pins Tested  Components
Failed  Pins  Failed  Components *

+
+  

 

Notes • Only available for AXI. 
• A component with multiple failures is counted only once as a failed 
component. 
• A pin with multiple failures is counted only once as a failed pin. 
• Components and pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
 

 

DPMO by Board Type, Components only (Pre-Repair) 

Definition Total number of failed components per million components tested.  Grouped by board 
type.   

(Defects per Million Opportunities)   
 

Formula 

 

 

million 1
Tested  Components
Failed  Components *  

 
Notes • A component with multiple failures is counted only once. 

• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
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DPMO by Board Type, Pins + Component (Pre-Repair) 

Definition Total number of failed components and failed pins per million components and pins 
tested.  Grouped by board type. 

(Defects per Million Opportunities)   
 

Formula 

 

 

million 1
Tested  Pins Tested  Components
Failed  Pins  Failed  Components *

+
+  

 
Notes • Only available for AXI. 

• A component with multiple failures is counted only once as a failed 
component. 
• A pin with multiple failures is counted only once as a failed pin. 
• Components and pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 

 

DPMO by Board Type, Pins only (Pre-Repair) 

Definition Total number of failed pins per million pins tested. 

 

Formula 

 

 

million 1
Tested  Pins
Failed   Pins *  

 

Notes • Only available for AXI. 
• A pin with multiple test calls is counted only once. 
• Pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
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DPMO by Test Station, Components only (Pre-Repair) 

Definition Total number of failed components per million components tested.  Grouped by test 
station. 

(Defects per Million Opportunities)   
 

Formula 

 

 

million 1
Tested  Components
Failed  Components *  

 
Notes • A component with multiple failures is counted only once. 

• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 

 

DPMO by Test Station, Pins + Components (Pre-Repair) 

Definition Total number of failed components and failed pins per million components and pins tested. 
 Grouped by test station. 

(Defects per Million Opportunities)   

 

Formula 

 

million 1
Tested  Pins Tested  Components
Failed  Pins  Failed  Components *

+
+  

Notes • Only available for AXI. 
• A component with multiple failures is counted only once as a failed component. 
• A pin with multiple failures is counted only once as a failed pin. 
• Components and pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 

Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
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DPMO by Test Station, Pins only (Pre-Repair) 

Definition Total number of failed pins per million pins tested.  Grouped by test station. 

(Defects per Million Opportunities)   
 

Formula 

 

million 1
Tested  Pins
Failed  Pins *  

Notes • Only available for AXI. 
• A pin with multiple test calls is counted only once. 
• Pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 

 

Failed Components (Pre-Repair) 

Definition Number of failed components, grouped by reference designator. 
Notes • A component with multiple failures is counted only once. 

• Which data is included when there are multiple test and repair cycles? 

 

Failed Components by Feeder (Pre-Repair) 

Definition Number of failed components, grouped by placement machine and feeder. 
Notes • Only available for AOI. 

• A component with multiple failures is counted only once. 
• Which data is included when there are multiple test and repair cycles? 
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Failed Components by Package Type (Pre-Repair) 

Definition Number of failed components, grouped by package type. 
Notes • A component with multiple failures is counted only once. 

• Which data is included when there are multiple test and repair cycles? 

 

Failed Components by Part Number (Pre-Repair) 

Definition Number of failed components, grouped by part number. 
Notes • Only available for AOI. 

• A component with multiple failures is counted only once. 
• Which data is included when there are multiple test and repair cycles? 

 

Failed Pins (Pre-Repair) 

Definition Number of failed pins, grouped by pin number. 
Notes • Only available for AXI. 

• A pin with multiple failures is counted only once. 
• Which data is included when there are multiple test and repair cycles? 

 

First Pass Yield (Pre-Repair) 

Definition Percentage (%) of boards that passed test or inspection.  
 

Formula 

 

 

100
Tested  Boards
Boards  Passing *  

 
Notes • Which data is included when there are multiple test and repair cycles? 
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First Pass Yield by Board Type (Pre-Repair) 

Definition Percentage (%) of boards that passed test or inspection. Grouped by board type. 
 

Formula 

 

 

100
Tested  Boards
Boards  Passing *  

 
Notes • Which data is included when there are multiple test and repair cycles? 

 

First Pass Yield by Test Station (Pre-Repair) 

Definition Percentage (%) of boards that passed test or inspection. Grouped by test station. 
 

Formula 

 

 

100
Tested  Boards
Boards  Passing *  

 
Notes • Which data is included when there are multiple test and repair cycles? 

 

Test Calls (Pre-Repair) 

Definition Number of failures, grouped by test call.  
Notes • If a component or pin has multiple failures, every test call is counted. 

• Which data is included when there are multiple test and repair cycles? 
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Post-Repair Quality 

Defective Components (Post-Repair) 

Definition Number defective components, grouped by reference designator. 
Notes • A component with multiple defects is counted only once. 

• Components marked Repair Later are included.  
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

Defective Components by Feeder (Post-Repair) 

Definition Number defective components, grouped by placement machine and feeder. 
Notes • Only available for AOI. 

• A component with multiple defects is counted only once. 
• Components marked Repair Later are included. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

Defective Components by Package Type (Post-Repair) 

Definition Number defective components, grouped by package type. 
Notes • A component with multiple defects is counted only once. 

• Components marked Repair Later are included. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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Defective Components by Part Number (Post-Repair) 

Definition Number defective components, grouped by part number. 
Notes • A component with multiple defects is counted only once. 

• Components marked Repair Later are included. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

Defective Pins (Post-Repair) 

Definition Number of defective pins, grouped by pin number. 
Notes • Only available for AXI. 

• A pin with multiple defects is counted only once. 
• Pins marked Repair Later are included. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

Defects (Post-Repair) 

Definition Number of defects, grouped by defect name.  

Calculation includes boards that have been completely reviewed using the Agilent 
Repair Tool. 

Notes • Components or pins marked as False Call or Variation OK are not included. 
• If one or more pin-level defects on a component (e.g., OPEN) are changed to 
a component-level defect (e.g., MISSING COMPONENT), each pin on that 
component is assigned the component-level defect.  This may cause a 
component-level defect to be counted multiple times for the same component.  
For example, four OPEN pins changed to MISSING COMPONENT result in MISSING 
COMPONENT being counted four times. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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DPMO, Components only (Post-Repair) 

Definition Total number of defective components per million components tested. 

(Defects per Million Opportunities)   

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool. 

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested  Components - Tested  Components  Total

Components  Defective *  

Notes • A component with multiple defects is counted only once. 
• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

DPMO, Pins + Components (Post-Repair) 

Definition Total number of defective components and defective pins per million components and 
pins tested.   

(Defects per Million Opportunities)   

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool.  

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested Pins  and  Components - Tested  Pins  and   Components  Total

Pins  Defective  Components  Defective *+  

Notes • Only available for AXI. 
• A component with multiple defects is counted only once as a defective 
component. 
• A pin with multiple defects is counted only once as a defective pin. 
• Components and pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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DPMO, Pins only (Post-Repair) 

Definition Total number of defective pins per million pins tested.  

(Defects per Million Opportunities)   

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested Pins - Tested  Pins  Total

Pins  Defective *  

Notes • Only available for AXI. 
• A pin with multiple defects is counted only once. 
• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 

Options: Calculation Tab for more information. 
• When the chart updates, every data point is updated to reflect the latest repair 

activity.  
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
 

 
 

DPMO by Board Type, Components only (Post-Repair) 

Definition Total number of defective components per million components tested.  Grouped by 
board type.  

(Defects per Million Opportunities)   

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed with the Agilent Repair Tool. 

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested Components - Tested  Components  Total

Components  Defective *  

Notes • A component with multiple defects is counted only once. 
• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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DPMO by Board Type, Pins + Components (Post-Repair) 

Definition Total number of defective components and defective pins per million components and 
pins tested.  Grouped by board type.  

(Defects per Million Opportunities)  

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool. 

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested Pins  and  Components - Tested  Pins  and  Components  Total

Pins  Defective  Components  Defective *+  

Notes • Only available for AXI. 
• A component with multiple defects is counted only once as a defective 
component. 
• A pin with multiple defects is counted only once as a defective pin. 
• Components and pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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DPMO by Board Type, Pins only (Post-Repair) 

Definition Total number of defective pins per million pins tested.  

(Defects per Million Opportunities)   

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool. 

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested Pins - Tested  Pins  Total

Pins  Defective *  

Notes • Only available for AXI. 
• A pin with multiple defects is counted only once. 
• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

 

DPMO by Test Station, Components only (Post-Repair) 

Definition Total number of defective components per million components tested.  Grouped by 
test station. 

(Defects per Million Opportunities)   

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed with the Agilent Repair Tool. 

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested  Components - Tested  Components  Total

Components  Defective *  

Notes • A component with multiple defects is counted only once. 
• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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DPMO by Test Station, Pins + Components (Post-Repair) 

Definition Total number of defective components and defective pins per million components and 
pins tested.  Grouped by test station. 

(Defects per Million Opportunities)   

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool.  

 

Formula 

 

 

1million
Defects    Active  withBoards  on  Tested Pins  and  Components - Tested  Pins  and  Components  Total

Pins  Defective  Components  Defective *+  

 
Notes • Only available for AXI. 

• A component with multiple defects is counted only once as a defective 
component. 
• A pin with multiple defects is counted only once as a defective pin. 
• Components and pins marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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DPMO by Test Station, Pins only (Post-Repair) 

Definition Total number of defective pins per million pins tested. Grouped by test station. 

(Defects per Million Opportunities)   

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool.   

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested Pins - Tested  Pins  Total

Pins  Defective *  

Notes • Only available for AXI. 
• A pin with multiple defects is counted only once. 
• Components marked as “No Test” are not included. 
• DPMO can be calculated based on pins, components or both. See Chart 
Options: Calculation Tab for more information. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

 

First Pass Yield (Post-Repair) 

Definition Percentage (%) of boards that contain no real defects.   

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool. 

 

Formula 

 

 

100
Defects    Active  withBoards - Tested  Boards  Total

OK N  VARIATIOor CALL FALSE  either  marked  calls  test  all    withBoards  Boards  Passing *+  

 
Notes • Which data is included when there are multiple test and repair cycles? 

• Scrapped boards are not included in the calculation. 

 

Agilent Quality Tool Online Help:  Printable Version  128 



Appendixes 

First Pass Yield by Board Type (Post-Repair) 

Definition Percentage (%) of boards that contain no real defects.  Grouped board type. 

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool. 

 

Formula 

 

 

100
Defects    Active  withBoards - Tested  Boards  Total

OK N  VARIATIOor CALL FALSE  either  marked  calls  test  all    withBoards  Boards  Passing *+  

 
Notes • Which data is included when there are multiple test and repair cycles? 

• Scrapped boards are not included in the calculation. 

 

First Pass Yield by Test Station (Post-Repair) 

Definition Percentage (%) of boards that contain no real defects.  Grouped by test station. 

Calculation includes boards that passed test or inspection and boards that have been 
completely reviewed using the Agilent Repair Tool. 

 

Formula 

 

 

100
Defects    Active  withBoards - Tested  Boards  Total

OK N  VARIATIOor CALL FALSE  either  marked  calls  test  all    withBoards  Boards  Passing *+  

Notes • Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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Throughput 

Boards Completed 

Definition Number of boards that either passed test or were completely repaired using the 
Agilent Repair Tool. 

Notes • Boards with defects marked Repair Later are not counted. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

 

Boards Completed by Board Type 

Definition Number of boards that either passed test or were completely repaired using the 
Agilent Repair Tool.  Grouped by board type. 

Notes • Boards with defects marked Repair Later are not counted. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

 

Boards Completed by Test Station 

Definition Number of boards that either passed test or were completely repaired using the 
Agilent Repair Tool. Grouped by test station. 

Notes • Boards with defects marked Repair Later are not counted. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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Boards Repaired 

Definition Number of boards repaired using the Agilent Repair Tool. 
Notes • Boards with defects marked Repair Later are not counted. 

• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

 

Boards Repaired by Board Type 

Definition Number of boards repaired using the Agilent Repair Tool.  Grouped by board type. 
Notes • Boards with defects marked Repair Later are not counted. 

• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

 

Boards Repaired by Test Station 

Definition Number of boards repaired using the Agilent Repair Tool.  Grouped by test station. 
Notes • Boards with defects marked Repair Later are not counted. 

• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

 

Boards Tested 

Definition Number of boards tested. 

Notes • Boards retested after repair are not included. 
• Which data is included when there are multiple test and repair cycles? 
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Boards Tested by Board Type 

Definition Number of boards tested, grouped by board type. 

Notes • Boards retested after repair are not included. 
• Which data is included when there are multiple test and repair cycles? 

 

 

Boards Tested by Test Station 

Definition Number of boards tested, grouped by test station. 

Notes • Boards retested after repair are not included. 
• Which data is included when there are multiple test and repair cycles? 

 

 

Boards Tested but Not Reviewed  

Definition Number of boards that failed test and have not been completely reviewed using the 
Agilent Repair Tool. 

Notes • Counts are not cumulative. 
• Boards with Active defects are not included in the calculation. 
• Scrapped boards are not included in the calculation. 

 

 

Boards Tested but Not Reviewed, by Board Type 

Definition Number of boards that failed test and have not been completely reviewed using the 
Agilent Repair Tool.  Grouped by board type. 

Notes • Counts are not cumulative. 
• Boards with Active defects are not included in the calculation. 
• Scrapped boards are not included in the calculation. 
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Boards Tested but Not Reviewed, by Test Station 

Definition Number of boards that failed test and have not been completely reviewed using the 
Agilent Repair Tool.  Grouped by test station. 

Notes • Counts are not cumulative. 
• Boards with Active defects are not included in the calculation. 
• Scrapped boards are not included in the calculation. 
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False Calls 

Average False Calls (AOI) 

Definition Average number of false called components per board tested. 
Formula 

 
Defects    Active  withBoards- Tested  Boards  Total

Components  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• Scrapped boards are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 

 

Average False Calls (AXI) 

Definition Average number of false called pins per board tested. 
Formula 

Defects    Active  withBoards- Tested  Boards  Total
ins P  Called  False                       

Notes • Defects marked as Variation OK are not counted as false calls. 
• Scrapped boards are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
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Average False Calls by Board Type (AOI) 

Definition Average number of false called components per board tested, grouped by board type. 
Formula 

Defects    Active  withBoards- Tested  Boards  Total
Components  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• Scrapped boards are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 

 

 

Average False Calls by Board Type (AXI) 

Definition Average number of false called pins per board tested, grouped by board type. 

Formula 

Defects    Active  withBoards- Tested  Boards  Total
ins P  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• Scrapped boards are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
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Average False Calls by Test Station (AOI) 

Definition Average number of false called components per board tested, grouped by test station. 

Formula Defects    Active  withBoards- Tested  Boards  Total
Components  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• Scrapped boards are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 

 

 

Average False Calls by Test Station (AXI) 

Definition Average number of false called pins per board tested, grouped by test station. 

Formula Defects    Active  withBoards- Tested  Boards  Total
ins P  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• Scrapped boards are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
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False Called Components 

Definition Number of false called components, grouped by reference designator. 
Notes • Defects marked as Variation OK are not counted as false calls. 

• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False Called Components by Algorithm 

Definition Number of false called components, grouped by algorithm. 
Notes • Multiple components may be counted per board. 

• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False Called Components by Package Type 

Definition Number of false called components, grouped by package type. 
Notes • Defects marked as Variation OK are not counted as false calls. 

• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False Called Components by Subtype (AXI) 

Definition Number of false called components, grouped by algorithm subtype. 

Notes • Only available in AXI. 
• Defects marked as Variation OK are not counted as false calls. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False Called Pins 

Definition Number of false called pins, grouped by pin number. 
Notes • Defects marked as Variation OK are not counted as false calls. 

• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False Calls by Test Call 

Definition Number of false calls, grouped by test call. 
Notes • Defects marked as Variation OK are not counted as false calls. 

• If a component or pin has multiple test calls, each test call is considered in 
the calculation. 
• Boards with Active defects are not included in the calculation. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

Agilent Quality Tool Online Help:  Printable Version  138 



Appendixes 

False PPM 

False PPM, Components + Pins 

Definition Number of false called components and pins per million opportunities. 
 

Formula 

 

1million*
Defects  Active withBoard on Tested Pins and Components - Tested Pins and Components Total

ins P Called False   Component Called False +  

Notes • Only available in AXI. 
• Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Components and pins marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False PPM, Components only 

Definition Number of false called components per million components tested.  
 

Formula 

 

 

1million*
Defects    Active  withBoards  on  Tested  Components - Tested  Components  Total

Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Components marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False PPM, Pins only 

Definition Number of false called pins per million pins tested. 
 

Formula 

 

1million*
Defects    Active  withBoards  on  Tested  Pins- Tested  Pins  Total

ins P  Called  False  

Notes • Only available in AXI. 
• Defects marked as Variation OK are not counted as false calls. 
• Pins marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False PPM by Board Type, Components + Pins 

Definition Number of false called components and pins per million opportunities.  Grouped by 
board type. 

 

Formula 

 

1million*
Defects    Active  withBoards  on  Tested  Pins  and  Components - Tested  Pins  and  Components  Total

ins P  Called  False   Components  Called  False +

 

Notes • Only available in AXI. 
• Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Components and pins marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False PPM by Board Type, Components only 

Definition Number of false called components per million components tested. Grouped by board 
type. 

 

Formula 

 

1million*
Defects    Active  withBoards  on  Tested  Components - Tested  Components  Total

Components  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Components marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False PPM by Board Type, Pins only 

Definition Number of false called pins per million pins tested. Grouped by board type. 
 

Formula 

 

 

1million
Defects    Active  withBoards  on  Tested Pins - Tested  Pins  Total

Pins  Called  False *  

 
Notes • Only available in AXI. 

• Defects marked as Variation OK are not counted as false calls. 
• Pins marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False PPM by Test Station, Components + Pins 

Definition Number of false called components and pins per million opportunities.  Grouped by 
test station. 

 

Formula 

 

1millio*
Defects    Active  withBoards  on  Tested  Pins  and  Components - Tested  Pins  and  Components  Total

ins P  Called  False   Components  Called  False +

 

Notes • Only available in AXI. 
• Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Components and pins marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False PPM by Test Station, Components only 

Definition Number of false called components per million components tested. Grouped by test 
station. 

 

Formula 

 

1million
Defects    Active  withBoards  on  Tested  Components - Tested  Components  Total

Components  Called  False *  

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Components marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False PPM by Test Station, Pins only 

Definition Number of false called pins per million pins tested. Grouped by test station. 
 

Formula 

 

1million
Defects    Active  withBoards  on  Tested Pins - Tested  Pins  Total

Pins  Called  False *  

Notes • Only available in AXI. 
• Defects marked as Variation OK are not counted as false calls. 
• Pins marked as “No Test” are not included. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Real 

False:Real (AOI) 

Definition Ratio of false called components to defective components. 
 

Formula 

 

 

Defects    Active withBoards on Components Failed - Components  Failed  Total
Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Real (AXI) 

Definition Ratio of false called pins to defective pins. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Real by Algorithm (AOI) 

Definition Ratio of false called components to defective components, grouped by algorithm. 
 

Formula 

 

 

Defects    Active  withBoards  on  Components  Defecive - Components  Defecive  Total
Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Real by Algorithm (AXI) 

Definition Ratio of false called pins to defective pins, grouped by algorithm. 

 

Formula Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Real by Board Type (AOI) 

 
 

Definition Ratio of false called components to defective components, grouped by board type. 
 

Formula 

 

 

Defects    Active  withBoards  on  Components  Defecive - Components  Defecive  Total
Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

False:Real by Board Type (AXI) 

Definition Ratio of false called pins to defective pins, grouped by board type. 

 

Formula 

 

 

Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Real by Component (AOI) 

Definition Ratio of false called components to defective components, grouped by reference 
designator. 

 

Formula 

 

Defects    Active  withBoards  on  Components  Failed - Components  Failed  Total
Components  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Real by Component (AXI) 

Definition Ratio of false called pins to defective pins, grouped by reference designator. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Real by Operator (AOI) 

Definition Ratio of false called components to defective components, grouped by repair 
operator. 

 

Formula 

 

 

Defects    Active  withBoards  on  Components  Defecive - Components  Defecive  Total
Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
• The user must have "Quality Administrator" privileges to see this chart. 

 

False:Real by Operator (AXI) 

Definition Ratio of false called pins to defective pins, grouped by repair operator. 

 

Formula 

 

 

Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
• The user must have "Quality Administrator" privileges to see this chart. 
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False:Real by Package Type (AOI) 

Definition Ratio of false called components to defective components, grouped by package type. 
 

Formula 

 

 

Defects    Active  withBoards  on  Components  Failed - Components  Defective  Total
Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Real by Package Type (AXI) 

Definition Ratio of false called pins to defective pins, grouped by package type. 

 

Formula 

 

 

Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

Agilent Quality Tool Online Help:  Printable Version 149 



False:Real by Pin (AXI) 

Definition Ratio of false called pins to defective pins, grouped by pin number. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Real by Subtype (AXI) 

Definition Ratio of false called pins to defective pins, grouped by algorithm subtype. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

Agilent Quality Tool Online Help:  Printable Version  150 



Appendixes 

 

False:Real by Test Call (AOI) 

Definition Ratio of false called components to defective components, grouped by test call. 
 

Formula 

 

 

Defects    Active  withBoards  on  Components  Defecive - Components  Defecive  Total
Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Real by Test Call (AXI) 

Definition Ratio of false called pins to defective pins, grouped by test call. 

Formula 

 Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Real by Test Station (AOI) 

Definition Ratio of false called components to defective components, grouped by test station. 
 

Formula 

 

 

Defects    Active  withBoards  on  Components  Defective - Components  Defective  Total
Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Real by Test Station (AXI) 

Definition Ratio of false called pins to defective pins, grouped by test station. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Defective - Pins  Defective  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed 

False:Total Failed (AOI) 

Definition Ratio of false called components to total failed components. 

 

Formula 

 

 

Defects    Active  withBoards  on  Components  Failed - Components  Failed  Total
Components  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Total Failed (AXI) 

Definition Ratio of false called pins to total failed pins. 

 

Formula 

 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed by Algorithm (AOI) 

Definition Ratio of false called components to total failed components, grouped by algorithm. 

 

Formula 

 

Defects   Active withBoards  on  Components  Failed - Components  Failed  Total
Components Called False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Total Failed by Algorithm (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by algorithm. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed by Board Type (AOI) 

Definition Ratio of false called components to total failed components, grouped by board type. 

 

Formula 

 

Defects    Active  withBoards  on  Components  Failed - Components  Failed  Total
Components  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Total Failed by Board Type (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by board type. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed by Component (AOI) 

Definition Ratio of false called components to total failed components, grouped by component 
reference designator. 

 

Formula 

 

 

Defects    Active  withBoards  on  Components  Failed - Components  Failed  Total
Components  Called  False  

 
Notes • Defects marked as Variation OK are not counted as false calls. 

• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Total Failed by Component (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by component reference 
designator. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed by Operator (AOI) 

Definition Ratio of false called components to total failed components, grouped by repair 
operator. 

 

Formula 

 

Defects    Active  withBoards  on  Components  Failed - Components  Failed  Total
Components  Called  False  

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
• The user must have "Quality Administrator" privileges to see this chart. 

 

False:Total Failed by Operator (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by repair operator. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
• The user must have "Quality Administrator" privileges to see this chart. 
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False:Total Failed by Package Type (AOI) 

Definition Ratio of false called components to total failed components, grouped by package type. 

 

Formula 

 

Defects    Active  withBoards  on  Components  Failed - Components  Failed  Total
Components  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Total Failed by Package Type (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by package type. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed by Pin (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by pin number. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Total Failed by Subtype (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by algorithm subtype. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed by Test Call (AOI) 

Definition Ratio of false called components to total failed components, grouped by test call. 

 

Formula 

 

Defects    Active  withBoards  on  Components  Failed - Components  Failed  Total
Components  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed by Test Call (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by test call. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins Called False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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False:Total Failed by Test Station (AOI) 

Definition Ratio of false called components to total failed components, grouped by test station. 

 

Formula 

 

Defects    Active  withBoards  on  Components  Failed - Components  Failed  Total
Components  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• A component with at least one false call is counted as a false called 
component, even if it has real defects. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 

 

False:Total Failed by Test Station (AXI) 

Definition Ratio of false called pins to total failed pins, grouped by test station. 

 

Formula 

 

Defects    Active  withBoards  on  Pins  Failed - Pins  Failed  Total
Pins  Called  False

 

Notes • Defects marked as Variation OK are not counted as false calls. 
• Which data is included when there are multiple test and repair cycles? 
• Scrapped boards are not included in the calculation. 
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Glossary 

A 
active alarm: An alarmed state for a particular chart. The chart data has not yet returned 

within its specified limits. 

active defect: A defect with the status “Active.”  It has not been changed to Repaired, Repair 
Later, False Call or Variation OK using the Agilent Repair Tool. 

Administration System: See ITF Administration System. 

administrator: An individual responsible for maintaining multi-user systems, including: 
adding and configuring stations, setting up accounts, installing and updating software. 
Also referred to as system administrator. 

Agilent 3070: Agilent Technologies’ in-circuit board test system family. 

Agilent 5DX: Agilent Technologies’ X-ray inspection system. Automated X-ray Inspection 
(AXI) uses 3-D X-ray testing to locate manufacturing defects. In addition, it does not 
require in-circuit test probing or visual access, and does not require a fixture. AXI 
pinpoints the exact location of the defects, helping to make repairs both fast and 
inexpensive. 

Agilent Quality Tool: An SPC/SQC tool for the Agilent 5DX and Agilent SJ Series test 
systems. The Agilent Quality Tool is a software application that runs on Client PCs. It 
allows users to apply SPC and SQC methods to improve assembly and test process 
efficiencies while helping users meet their targeted quality levels. 

Agilent Repair Tool: The common repair tool for the Agilent 3070, Agilent 5DX, and Agilent 
SJ series test and inspection systems. The Agilent Repair Tool is a software application 
that runs on a Client PC. Common abbreviation is ART. 

Agilent SJ Series: Agilent Technologies’ automated optical inspection systems. Current 
products are the Agilent SJ10 and SJ50 inspection systems. 

Agilent SP Series: Agilent Technologies’ automated optical inspection systems. Current 
product is the Agilent SP50 inspection system. 

alarm event: The event that causes a chart to go into an alarmed state. The alarm event is 
recorded in the Alarm Log. 

alarm limit: A defined limit for a particular chart. The alarm will go into an alarmed state if 
the limit is crossed. If a particular chart has an alarm limit set, you will see a 
horizontal red line on the chart at the limit value. Alarm limits are set from the Chart 
Options dialog box. Alarms are set specifically for an individual chart in a named View. 

alarm log: The list of recent alarm events. 

alarm notification: An alarm dialog box is displayed at the Client PC to notify a user when a 
chart in one of the defined Views at that Client PC has gone into an alarmed state. 
This alarm dialog box is displayed when the data for a particular chart goes outside its 
defined alarm limits. 

alarmed state: An alarmed condition. A chart is in an alarmed state if the data that the chart 
is monitoring goes outside of the limits set by the user. 

algorithm: In the Agilent Quality Tool, an AOI "algorithm" corresponds to an AOI device type.  
An AXI "algorithm" corresponds to AXI "algorithm families" that are based on the 
structure of the joint.  Examples of AXI algorithm families are BGA, BGA2, Gullwing, 
FPGullwing, Connector, Res, Cap and Chip. 

AOI: Automated Optical Inspection. The Agilent SJ10, SJ50, and SP50 are automated optical 
inspection (AOI) systems. 
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ART: Abbreviation for Agilent Repair Tool. 

assembly: See board 

assembly process: Test systems, software, and methodologies used in the development of 
printed circuit board technology. 

assembly type: See board type 

AXI: Automated X-ray inspection. The Agilent 5DX X-ray inspection system is an AXI system. 

B 
board: The physical printed circuit board containing the devices intended for test. One or 

more copies of a board may exist on a panel. 

board type: The classification of a specific printed circuit board assembly type, usually named 
or numbered. 

Boards Tested but Not Reviewed: Boards that have failed test and have not been 
completely reviewed using the Agilent Repair Tool. 

C 
CAD: Abbreviation for Computer Aided Design. For the Agilent 5DX or Agilent SJ Series 

inspection systems, CAD data is the source data used to design or describe an 
unpopulated circuit board. For Agilent in-circuit test systems, CAD data is used to 
describe the layout of a printed circuit board to the test machine. 

chart information: The definition or formula used to calculate the dependent (y axis) data 
for a particular chart. 

chart options: Chart options apply to a specific chart. The Chart Options dialog box includes 
an Alarm tab, a Filter tab, and, for DPMO charts, a Calculation tab. The Alarm tab 
allows the user to set alarms specific to that chart. The Filter tab allows the user to 
specify the placement machine. The Calculation tab may be used to specify the 
method to count "opportunities for defects." The user has the option to calculate 
DPMO by counting (a) all components tested (b) all pins tested or (c) the sum of all 
components tested plus all pins tested. 

Client PC: The computer on which the Agilent Repair Tool or Agilent Quality Tool software 
runs. 

combine data: Combine data for multiple items into one line on a line chart (i.e., aggregate 
the data). 

completely reviewed: A board has been completely reviewed at ART when all test calls have 
been marked either repaired, repair later, false call or variation OK. There are no 
active defects remaining on the board. 

component: An individual part with contacts (pins) that are connected with solder joints to a 
corresponding set of pads (land pattern) on a board. Also referred to as a device. 

component level defect : A defect that applies to an entire component (for example, 
component missing). 

computer-aided design: See CAD 

Create View Wizard: An easy method in the Agilent Quality Tool for a user to select the 
specific set of test and repair data from the Agilent ITF Server that they want to 
monitor. The user selects the Test Stage (AOI or AXI), test station(s), board type(s), 
time frame, method of organizing the data, the tabs, and specifies a name for the 
View. 
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D 
dashboard: The group of live charts on a tab in the Agilent Quality Tool, used to monitor 

quality, throughput, or false call levels. 

data included for retests and multiple repairs: For pre-repair calculations, the Agilent 
Quality Tool uses the test results from the last test run before the board is opened at 
ART. For post-repair calculations, the Agilent Quality Tool uses the repair results from 
the last time the board is opened at ART before any re-test occurs. 

data store: The subsystem within the Agilent ITF where the test and repair information is 
stored. 

defect: A physical problem with a component or pin. The defect is specified in the Agilent 
Repair Tool when the component or pin is marked repaired or repair later. 

defect call: An item in the defect table or defect list. A possible defect. 

defect list: A user-defined list of defect types, such as open or short. The list is configured in 
the ITF Administration System and used in Agilent ITF applications. The defects listed 
in the Agilent Repair Tool are based upon the defect list. 

defective component: A component with at least one real defect.  The component or one of 
its pins has been marked either repaired or repair later using the Agilent Repair Tool. 

defective pin: A pin with at least one real defect. It has been marked either repaired or 
repair later using the Agilent Repair Tool. 

Defects Per Million Opportunities: See DPMO 

device: A component. 

Do not repair: See false call or variation OK. 

DPMO: Defects Per Million Opportunities. The number of defects observed in a manufacturing 
process, divided by the number of opportunities for a defect to occur, multiplied by 
one million. A "defect opportunity" is defined in the Calculation tab of the Chart 
Options. 

drill-down: By clicking a bar in a Pareto chart or a line in a trend chart, or a drill-down 
button, the user may get more specific information for the current chart. This allows 
the user to investigate the factors contributing to the data on the current chart. 

F 
failed component: A component with at least one test call.  

failed components: The number of components with at least one test call.  

failed pin: A pin with at least one test call. 

failed pins: The number of failed pins with at least one test call. 

failure: A possible defect, called by a test system. 

failures: The number of possible defects that were called by a test system. 

false call: There is no defect associated with this indictment. 

false PPM: The ratio of false calls to the total number of defect opportunities. 

false failure: See false call 

False:Real: The ratio of false calls to real (valid) defect calls. 

False:Total Failed: The ratio of false calls to the total number of defect calls. 

feeder: See placement feeder 
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filter: A method to narrow down a search by specifying certain characteristics. 

first pass yield (post-repair): Percentage of boards, that, after review at ART, contain no 
real defects. Post-Repair yield would be 100% if every board tested either passed test 
or had no necessary repairs after review with the Agilent Repair Tool. 

first pass yield (pre-repair): Percentage of boards that passed test or inspection. Defined 
as (boards passed)/(total number of boards tested)*100. Pre-repair yield would be 
100% if every board passed the test or inspection phase. 

fixed time period: A time period with a specific beginning and end, in contrast to a moving 
time period such as the last 24 hours. 

Framework: See Agilent Intelligent Test Framework 

G 
graph: See chart. 

I 
ICT : An acronym for in-circuit test. The Agilent 3070 is an in-circuit test system. 

image: An X-ray or optical image of a possible defect. X-ray laminography allows for X-ray 
images from X-ray inspection (AXI) systems such as the Agilent 5DX. Automated 
optical inspection allows for optical images from AOI test systems such as the Agilent 
SJ10 or SJ50. 

In-circuit test: An analog or digital test technique that measures the value or performance of 
a component on the board under test. Abbreviated as ICT. 

indictment: A possible defect. A defect call. 

Intelligent Drill-Downs: A patented feature of the Agilent Quality Tool that allows the user 
to "drill down" on a chart to learn more about the factors contributing to the displayed 
data.  The "intelligent" part of the drill-down is that it automatically generates a 
deeper view of the information most likely needed to determine root causes.  
Intelligent Drill-Downs anticipate questions that the process engineer might ask in a 
given context, and provide information to help the engineer answer these questions.  
Intelligent Drill-Downs are based on extensive research with process engineers.   

Intelligent Test: An Agilent Technologies strategy for electronics manufacturers that enables 
optimized manufacturing processes built on best in class testers and common tools. 

Intelligent Test Framework: A collective term that refers to the Intelligent Test Framework 
software and server. 

Intelligent Test Framework : A collective term that refers to the Intelligent Test Framework 
software and server. Abbreviated as ITF. 

Intelligent Test Software Solutions: A suite of software applications that runs on the 
Intelligent Test Framework. 

interface: Interaction or communication is achieved at an interface. A user interface is a 
computer screen where you receive and/or enter information. 

IPC: The Institution for the Interconnecting and Packaging of Electronic Circuits. An 
international standards generation body that is accredited by ANSI. 

IPC Standard: A type of standard developed by the IPC Association Connecting Electronics 
Industries. The capability supported by some operating systems that allows one 
process to communicate with another process. The processes can be running on the 
same computer or on different computers connected through a network. The Agilent 
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Repair Tool and Agilent Quality Tool are based on ANSI/IPC standards 2547 (CAMX) 
and 2511 (GenCAM). 

ITF Administration System : A browser-based application on the ITF Server that is used to 
configure system properties such as user access, repair configurations and framework 
services for ITF Software Applications. 

ITF Server: The server hardware on which the ITF software runs. 

ITF Software: The software that allows for data sharing and communication among test 
systems and applications, such as the Agilent Repair Tool and Agilent Quality Tool. 

ITF Software Solutions: A suite of software applications that run on the Agilent Intelligent 
Test Framework. 

K 
keypad: A keypad is an optional input device for the Agilent Repair Tool. The keypad is 

comprised of buttons for the most commonly used functions in ART. A keypad is most 
useful with AXI and AOI repair. 

L 
LAN: See Local Area Network 

line chart: See trend chart 

local area network: A group of computers at a single location (usually an office or home) 
that are connected by phone lines or coaxial cable.  

log in: The method to establish communication with a computer program. When the Agilent 
Quality Tool starts up, the user must first log in to the program. Login requires a valid 
user name and password. Your system administrator sets up the list of valid user 
names and passwords. 

log out: The method to end communication with a computer program. A user will log out 
when he/she wants to end communication with the software applications. Another user 
may then log in to the software application. 

M 
MHz: Megahertz  

O 
open: The electrical isolation of two conductor nodes. “Open” is most commonly used when 

the nodes are supposed to be electrically common, but are not. 

opportunity: Any opportunity for a defect on a pin or component. The pin or component must 
have coverage in the test plan. 

optical tester: An optical test inspection machine. The Agilent SJ10 and SJ50 are sometimes 
referred to as optical testers. This equipment is more formally referred to as an 
automated optical inspection (AOI) system. 

P 
package type: For AOI, the package type is a name or code used to designate the shape and 

size of the component. Examples of AOI package types: SOIC14 or C1206. For AXI, 
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the package name is usually derived from the land pattern name. The package data 
includes such characteristics as pin dimensions, locations, pitch and pin type. 
Examples of AXI package types: SO14_U or 1206_C. 

page-sensitive help: A type of online help that gives specific information about the current 
screen. 

panel: A printed circuit board assembly which can contain one or more boards. Note: for the 
Agilent 5DX, any single board loaded directly into the tester is considered a panel for 
the purpose of panel programming. 

Pareto chart: A vertical bar chart showing items in prioritized order, so it can be determined 
how much each individual item contributes to the overall problem. A Pareto chart is 
often used to determine which are the largest problems that should be addressed first. 

password: An individual identification code required to access a board, file, computer or 
program. The password helps ensure that unauthorized users do not access the 
computer. 

PIN: Personal Identification Number (a numeric password). 

pin level defect: A defect that applies to an individual pin or joint, rather than an entire 
component. Examples include open or short. 

pin number: A unique number is assigned to every pin of a given package in the package 
Neutral Data File (NDF). The pin number must match the respective pad number.  

placement feeder: A specific feeder on a pick and place machine. 

PNG: Acronym for Portable Network Graphics image file type (.png). 

post-repair quality tab: The tab in the Agilent Quality Tool for monitoring post-repair quality 
which incorporates data from the Agilent Repair Tool with test and inspection data. 
Pre-repair quality data comes directly from the test and inspection systems connected 
to the Agilent ITF Server. 

post-repair yield: See first pass yield (post-repair). 

PPM: parts per million. 

pre-repair quality tab: The tab in the Agilent Quality Tool for monitoring pre-repair quality. 

pre-repair yield: See first pass yield (pre-repair). 

R 
RAM : Acronym for Random Access Memory. RAM can be read from or written to by the 

computer or other devices. 

reference designator: A name used to designate a particular component on a specific board 
type. Examples: U11 or R4. 

repair later: An action taken to indicate that a specific pin or component is to be repaired 
later. It may be for reasons such as a lack of tools, components, or expertise that the 
repair operator indicates that this defect will be repaired later. 

repaired: An action taken to confirm or change the specific defect for this pin or component. 
This defect has been addressed. 

reviewed board: A board with all test calls marked repaired, repair later, false call or 
variation OK.  There are no active defects remaining on the board. 

S 
S/N: See serial number 
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scrapped board: A board that is discarded.  A board may be marked as scrapped using the 
Agilent Repair Tool.  

serial number: A unique series of numbers and/or letters used to identify an individual board 
or panel. Usually encoded on a barcode label. 

Stage: The stage of the manufacturing process: AOI_SJ, AOI_SP, AXI or ICT. Also referred to 
as Test Stage. 

status: The status of a component or pin in the Agilent Repair Tool. Status is active, repaired, 
repair later, false call, or variation OK.  

T 
test call: A named test failure, such as open or missing. 

test failure: The problem or fault identified by the test or inspection equipment. Examples: 
short, open, or measurement failed. The in-circuit test machine determines the test 
failure name. 

test name: The process step ID of the in-circuit test that failed. Process step status record 
from the IPC-2547 standard. Examples: U3, R1, or C56. 

Test Stage: The stage of the manufacturing process: AOI_SJ, AOI_SP, AXI or ICT. Also 
referred to as Stage. 

test station: A specific test or inspection system, identified by a name or identification 
number. 

test system: A generic term used to describe a test or inspection machine, such as the 
Agilent 3070, Agilent 5DX, or Agilent SJ Series. 

time frame: A period of time with a specific date and time for its beginning and end. 

trend chart: A line chart that displays a trend over time. For example, pre-repair first pass 
yield over the past 24 hours would be displayed in a trend chart. 

U 
user: See user name. 

user name: Name used to log in to the Agilent Quality Tool from the login dialog box. The 
system administrator sets up all user names. 

V 
variation OK: For a given indictment in the Agilent Repair Tool, the slight variation from the 

ideal is acceptable. 

View: A View defines a subset of test, inspection, and repair data that resides on the ITF 
Server, forming the basis for charts in the Agilent Quality Tool. Views are created and 
named in the Agilent Quality Tool. 

X 
X-ray: A form of electromagnetic radiation, similar to light, but, of shorter wavelength and 

capable of penetrating solid materials. Used by X-ray inspection machines to examine 
printed circuit board joints. 

X-ray inspection: A method of examining printed circuit board components and joints using 
an X-ray inspection machine such as the Agilent 5DX. 
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X-ray tester: An X-ray inspection machine. The Agilent 5DX inspection machine is sometimes 
called an X-ray tester. 

XML: Abbreviation for Extensible Markup Language. XML is a specification developed by the 
World Wide Web Consortium. It allows designers to create their own customized tags, 
enabling the definition, transmission, validation, and interpretation of data between 
applications and between organizations.  

Y 
yield: The percentage of a process that is free of defects. 100% yield = zero defects. 
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